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SDON=2a DFHEE. BERBIVRREADERBEEZUTICEEHLES

FitRE

Fa—

Fa—LiF. HEEBD/N—MIRREINDIBRLGIEBRNERTH/\vtE—2DIE

T, BE.EEICERTIAMPVOERDR (AKX RIMAFDHLE) (TTL

— XN —ZFETHOICFERAINET, T ABEOF1—=UJ #5550,
—VUEENDELLSTREMDH S AN T —ERTIHGRIZHERINET,

Fa—(L@BE. NESHDHARXDEFERANTERE SN BIRSN-F21—DERD
BHID /NN E—DDEBIZTHMNYOILRREINET , BE (L. ERBO YA XDKEF
EFXa—DLETVWITNNIHEETHIET. F2a—5HLTL—NV—DZDHMHREE
BELBWIEERDYPTRLET . Fa1—TlE. Fa2—%EETHHEIJD/—ME
[CIERARINSG—EBORELENERINETH R5— 7—TasFaL—3>,
BFUBALBIERRTHENTEET . EREIN-F1—DEROTHEH. XU
F1—DHEDN\VE—CDEEIZESTIX, Fa—DORBKFICEHELESOEEN

WEICEDIGEELHYET,
me
) ' - \
{;‘;? L F3 r.-' {;? _r ‘.l H' .__,l_
PP sempre

Dorico Tl&, ELWERDF1—%HECERTESLITTHL, B X1 —%1&F
FALTHELGHEFECUIL. LEDEEITHTIERARE )T ILIA LIZRM
TEFET, COISILEEERTOS S LIE Dorico DSHZHYFEE A,

F1—FRTTDLATIN Fa—(XEDLATINTEERTEET A, FHARE
TIRIIWRATZLATINIF1—DRABRERTINFR A, [FEALEDEED RO
FTlIE, F2—[FEB/N—FRNIZOARTEIND=HTT , TO=HHNEAZEDNDIIL
AT Tl Fa—IEBICHAFELTRRSINET , F-ZL¥vL—E1—ZERAL:
FE . BIRENT=F1—DEEORBENHARELELITRRINET,

2L TLA72bA T3> (Layout Options) IO FL—+— (Players) IX—2 T
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[F1—%RT (Show cues) AT avEaA T dHE, Fa—ETILRATLATY
FOR—VE1—IZRRTEET,

FNISRALTL—V—DEEDERD/NN—,L AT IMIRREINDZELHE
EDX1—ZLATINMIRRLEVNKIIZT IBLENELDIEELHYET . CDi5
B F1—ZIERTITTBICE, TANTAARILDIFa— (Cues)ITIL—TIH
BIERR (Hide)lzAUIZLET,

F1—DER: F1—ZERTBICIE EBEE-FTHF1—ZRTIEHERERER
LET . Fa—DREAHoMLHADOTVSIEE . BFIRMEDKRFEERLT,
[Shift] ZHLENGKRTHEDKFFZEY) VT HILET, BUGRSTHERRL
FT o F21—DRSFEHENSHHEITHETES-O. RUNOIEHEICRET SLE
[FHYERB A F1—ZERTSEDIVARYILAV S ETEYGEHEZEIRLTH S,
UTOWThODBREETEVET,

o [Shift]+[U]Z L TH1—DRyTA—"—%REK
o [E2FE (Write)] » T a—%4{ERL (Create Cue) Z:&EIRT S

o Y RYDAEBOREY—LRysRIzHLGEMShE Bl Ravzs)vs
LTHxa—/\RILZERE. [F2—%FHEA (Insert Cue)l&V)vILET,

F1—DRYTF—/IN—PRFREINDIDT, F1—HHEINDIEEEEETTH1UX
FoILAURDBRIEAALET AV RMYIIAVREDIELODXFEANTHE.
RYTH—N\—LEIZIEHEIL DAV RIYIILAV N B DA 21— HEE T AV AR
IWAURERIRT BICIE, TRENEZMLTEMOD AV AR ILAVNEETH—YILER
gL THD [Return] ZHRLTRYTA—/N—IZLBTEZANT HH ., YORATEEY
)y LET , [Return] 2H5—ERLTRYTH—/N"—DRNBEHEEL. F21—%1F
BLET,

RNR=—VE1—TINRITLAT IFDHmEETEOTNDEE ., CORRATIEFa—
DAARDHRTIN, HAFIZIEBRSNF2F 21— DAV XY LAV MDA RIH TR
RENTWBIET TT . /IS—bLATIMIUYEZDE FHRATEDII42ED
(Window) ] » TH928—R—kDL A7 Ik (Counterpart Layout)l. F71=(Z%)
HEREDYaI—rhybd— [W] TUYEBDLYEY), BIREN-F2—DEEDNR
BRRTINET,

Ry TFH—/IN—IZRREINDA VARG AR DIEE ) AL, F2—FERT S
IN—FDAV ARG AVRBERTRENETA (RTRPDAVAR LAV DHEH
B L THF1—ZERTHIEIETEFLA) B MDAV RISILAVREITRT
RINSIN ET7/GERERZAVDEROGEE . ERNTNTHh (A
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Piano (a) & Piano (b) MD&3IZ) YRMIRFRSINET  BEEITERDAUXE
GILAREENENERIC) RAMIRRSNE T LA L. TSI DH BT
L—NY—DR S LtyrEERLTWSGEE., FILEYMNERT H0EDUEDDAS
VARGV AT 1 —DIEFHELTREREN, 2R EX YIRS LD F1—FERK
TEFEY (L TERTIVNERE X1 —IERTAILIELTEREEA).

F1—DEUBDRE: Fa—/\RILDIF1—DIRE (Suggest Cues) o ar

[T, RAA7ATHF1—ZANDDICRBELGMEZ R DOITHIRITKRICILET,

Dorico Tl RED7O—DIREDL AT IM—E B
Bl (FHEAERETIE 30 ) LLEfIEBERLTLVENTL
—YV—HWBDEE. ZTDBMEIT R THETETET . AL
DORIOFHEICIE, METECIEBTII RSB &L S X
EEAVET, ChlE BOTURIETO—h TRIETH
ERETEDILICmMA, —HFEIEEAEELTELTA
DIENEELFELETH. L BIETEIC 1 BPORITH
B2 TT, COKSIC B EVLSHEXHEZIEET S &
T, Fa—ICEULBRERETHEEIC—BEH B
BIEMTEET,

AVRARGILAVMIR T X 1—ZIRETAEDEELL
SRILEDRESFIBET HICIE. THRIERER: n #
(Resting for: n secs)lIZEZEZELFET

KIEDRSERHET BT, UN—PILI—VEERET D
MNERTONEEIRTETY  UN—HILI—TIL, Xl
DFLNEIL I PEDMDERIRELG DGt ToN
BEL B Fa—EMNGKTELTL—V—ICZE DB
MIFoZFY DD BIHEENHAH=H. VN—HILI—IhH
BIBBICEFAIT—FZ ) EINT HIMEINERDDHIEN

Suggest Cues

Restingfor: 30 C

Rehearsal marks:

Consider

Update

Flow: Allegro

Layout: Orchestra

Instr, Bar
F.Hn(F)1 2
Tpt (B Flat) 3
Ton 30

30

1gnoce
U Highlight suggestions

Playing instruments:
Sleigh Bells
Glockenspiel
Celesta
Plano
French Homn (F) 1

TEFET, BHDOBE AT EHARELTEIZHEET 20+ TIHEL =0, #¥1H1E%
ETIEYN—SFILT—IITERENET,

F. BRIOTL—V—DERLTOVEVEICASF1—2ZBETHINERTHH
DBRHTEET . AV AMIILAVINBERICERT HEMDF 21— (T EICERSN.
Fa1—ZEZRTAHIIRELTN=ELTH, ZDBAMNMRESNSERFHYFEE A,
L. FEO-HDOFa— (EBENERICRIFITIERICIERESNT. TL—F
—IRARLEDOREITHEZREDENLIITTH=HDF1—) BHoHEE. F
1—%EZEETHLOIRELTLNEL, 47— EVbENFET,

BIRATET L5, [E#H (Update)lz0)voLET [EFH (Update)IR2DTF
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[ZIE. RRICF21—DREVRMNEEHFLIEZICTIT1Toz78—ELAT IR
DEBHMNRTEINFET, ChIKY, TOC NN THBEERYIRLI=Y. LA4T7 Ik
EO0—FYPYBZYULEHETHF1—DREVRMEBEERRLIZEEIZE, RRS
NTLBRENEDTOA—DEDLATIMITEELDLEOMN—BTHMYET,
thDTO—OL AT I T HF1—DRELZERTDICIE. HRETEHT70—R
DT ATLEERT EDLATILEYYEZ T, [EH (Update) 122y ILET,

KBPELTODI I TEDRET—970—0 1 DELT EEBED/A—FL AT IR
tIYEBZTCIESH (Update)lz0)vIL T, ZDINR—rDTL—FY—IZx T B5F 21—
DREZEBLTHAELHBYET , COREVRMIIE, ZDOLAT IO TL—

V=2 T RIRELNEENEEA, ZILRAOTLATIONMIYBEZLE (W]F—
ZHLEY). FRENDREICHLF1—ELTHERDREMZROT72ANDIET S
ENTEFT, T, F1—DREYRMEHFLIZEFRIT L= AT IREST

SfzYFEYTEET,

Fa1—DREVAME., MEIEFE=FKRIEDREIDIETY—FTEFET, F21—DIR
EYANADTEIIVITHE TOME~NEEBELE T F-MRETIE,
BIERICERTIHALY 5 H5 10 WEIETOEBENFGERARTINT
— BTN NSO, BINRRLTWABRIZHEIZERN T, saARTOEH .
ERTE5F1—DEIDHEEXTEFRVICSTETIOTIEHYEL A, TR
[CEoTIEBEULIEEL LA HEENHYET , RUERARTEHELEZWMGEF. VR
FDTDOMREZEMRE (Highlight suggestions) IOF v I RyIREATIZLTIE
¥ (Update)IZBEVJYIL. REZERLEGELET,

DAL F1—DRELTERT DL EEPDAIURRILAVE (Playing
instruments) IOYRAMERSINET , URMIEF 1 —DNRRINEA DAY )L A
VRHAEERICEIRTAEAELY 5 BHD 10 BEIETORBISERELTLSAU AR
GILAVIMRREN, F2—ELTHERATIDITELYGA RS ILAVIERDITH
FTOIZRICIBEFET .

DRAMDSBIRLZWITNADIGFRICF1—ZERT dE. ZDREEFa1—/ARIL
DYAI L BEIBICHIBRSNE S IREZHRL T, RRICIFZIITESGRUOEHIM
ENBF1—DHo=HBIF VANTDT I avn—I2H 5B (Ignore)1&4)
VILTREZFRRICTEEY 2L, [EH (Update)1ZV)vILTIYRMEAE
BLEETE ZORENBERENDGELHYET,

F1—DORZDHE: FRLEF1—DORSFVDOTHHRETEET . BRI+

A—DEEZREEFTRRLTVDEEIT, F2—DRABMETHLEDEREE

RERTHINNLEERTHE FINILDERABIVCF1—DRTHREICHLANURIL
PARRSNFT,
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F1—DRIZFZEETIHEEE. VWTHADNURILED)YILTRZVILET &
BEDERICH ST EOHICTNFESIEFNF1—ITRREINFETS, Fa—F. EFD
BICHE 2> TEALNIL, EHTOEFDRPDERTHOTH, ECTHRIBEIUHR
THECRETETY L BT CEFORFDEFTIRESYRDHOYT
B2F¥21—MNTL—V—IZEoTHRAPLT VLD THLIN . ERTIVENHYET,

SEEE—R Db DBEELRRR. [Alt]+[—)][—] ZEALTF2—DRSIEREFLE
FBFEBELEY. [Shift|+[Alt]+[])[-] ZFEALTXF1—DRIZLEELIYT
=F7,

BIRINF-F1—DEEDFE: Fa1—ICRRESNDEEIZIX. LEDAURRYIL A
CrDEELSBMICRBESN, HEQOREICMAON-ERZBBMNICF1—IZK
RENFT M, LEDEEEF1—TEIRTSHIEETEFER A Fa—ITRREIT
EEDNBELEFTEILETEEFITN. AS—DMBOCFREDOESDIAGHHE. B
EDAVRRG AV DEZEDOABICIEHELLEVWERADEREDAITHEAET

FEEEETITE. F2—NOEFDELRBTDRELAEE. Ya—bavbD
[Alt]+[-] BV [Alt]+[=] ZFERALTEETEFTY . F1—NDEHFDORELEELE
LTH. LEDERDOREAEICHEIHYFEA,

Fa—RADOKRFF: Fa—ANEHDRPTEHRIAFE TR T ITHHE. NEIREIFTT
L—YV—DEBNERICAERTAMEDELLMNEVADREN, Fa—ADEFHF
YA XITEL-BIEARFTEDOONET  ChIZEY, BERTHEFET21—DY)
ALREDLSITHAEDLEEDIETL—V—HERFELOITLRYET,

BRIN =X 21— DEEOHAIZARF TEOKLELMEE . F2—FRNILETH
ARZEBIRLT. TO/T4/8RI)LDTFa— (Cues) T INL—TFI2HBTF21—EBD
hFEERT (Hide rests around cue)IDTE/NTAEAVIZLET , F1—LE
HEOERFELITNEIREOBEED D, F2—DERFHAXITHLIARFFIL, #IR
LRELTEEE A

VR ETIX, BREN X2 —D N\ E—DIZEE RO YA XD MR FERT
SNBI=H . BEENEZLGVEADR MY OTLGO>TOET  Dv X GE, Fa
— DM DN—EDIZV UERLLGHARENEEELTENNSEE T, Fa2—
DOREIONEFRFERTLEVADLRWMEEELEHYET . COBZE(E, M4+ T3
> (Notation Options)IDIAFF (Rests)IR—C TIxa—D/IMRFF (Bar
rests in cues)1ZI/MIARFEERE (Omit bar rests)JIZERELET .

EBDYAXDNEHREF, BIREN-F1—DEROFEDARIZEHETH
B ENRAEINFE S, Fa—NTLREOFENMERSN TV SES(E. /M
AR EF1—DEFOTICEESN, F2a—ATTREDFEAERAIN TS
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SEIE. MIRFEX1—DFBFOLICRESNET . EEDH A XD /NEIHKRFD
B, TANRTANRRILDIEFEARR (Notes and Rests)|F IL—TFI2H Bk
FOLIE (Rest pos.)IDTANTATHETEET,

F1—ADFEDAMR: Fo—IT@E. EEENF1—FEFELLGWILERTO
S EBEBOHARADINGRFERLICRTINTTA . F1—HNOEEN 1 FOH
THEREINTWSIGE. IR TOERIEERCHFEDAMICGYET =1L, +
A—DEENEHOFHTHEBSINTVWSEEE. FEDAAINLLEDEFLELREL
[ZRYET,

BE—DERIZESF1—TlE. HAREDOHFEDHRIL. BHE D/ AN
DE 3 MO TITKSFZEFITEE, EIKEBERF EAESERYET,

Fa1—SRLFLEFACIRERIRLT, TO/8F4/RILDIF 21— (Cues) )T IL—TF
[2HBHIFEEBDRZE (Voice direction) IO TA/NTAEF 2T HIET, MHRTE
DHEDHAZE LEETEET,

F1—ANDEAEBEEVF2—ALLDEA: BIELI-FDERIRNOF1—IIEFED
B8, F1—DFRRMEIC, F2—DF 1 FITERTH2IARTINES, B
2. BELEBEORATF1— OGS, F1—DREENGILAIZHULE
ADRF1—DRTHEIZRTINET, BIERERDISE . COZ(TEHBMICE
BESN-MEDFFTHEDHYELEAN, F1—ITHMBFZERTHERCIRELNS
FNDBE . ZMDMNEZAESTIVENELDZENHYET . F2—HNOEFRHFA
DEABLVF1—HNDEFNODEAE, FEET—FTREDRAERLAETHR
£TEEY,

JALIZEDFa1— Fa1—,LTERFRTDIDIVXLEFTTRWMNMEEEHYFET . 1=
AL, ZHOEBHIECHEBNE) A LERBISERTAI5AHETT URXAIC
FAX1—(FERDEICRTENET . LEDAVRARYILAVID T RTOEFITH
BEORILCERICEESNh. BHMELESNER. BFELESHLVMREEINET,
DALIZEDF1—ZERT BICIE. BEDHEZTHEEERBIOFL—ZEIERKL.
TANRTFANRRILDNFa— (Cues) 1T IN—TZH BT X LITESF1—
(Rhythmic cue)IFTANTAZAUIILET THEEBEBN TN TERDE 5 &
KU LR RSn, TEERE (Distance)lTO/N\TAZAUICTHE, ERICIHEDIT-Y
BELF-YUTEDIIITLYET BETOIIZT HEERE 5 ROICLELGY EX K
ECTBHIFEHREEFTDOERMIASTET . VALIZKSF 21— FEHDERIZE
TEEREINBZIENZ N =D, F2—FNILDTFRNEERTHEENTT, Fa1—
SRILDTHFAITEAMRTERF (Start labe) 17O/ T4 TEETEZXT,

EERERIODF 21— BEFRBITEBRORENST1—ZERTHIEE. CNIE
YA LIZEBFa—ELTHERESNE T TV X LIZLSF21— (Rhythmic cue)17 A
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INTAEATITTBHE . T RTOEFIIER LORCME. FIHRETIEE 3 KL
[CEEEBINET . EHEERLOERLGLMUBICBET SICIE. F2—SNILHHAF
ZEIRL T, TANRTFA/RRILDIFa— (Cues) T IN—TIHZMBEZTEETDOAE
(Unpitched notes pos. )17 0/XT4&AICLET (0= 5 3 #R.4= 5 5 #&.
4= % 1 #).

BERERA O 21— ETERROERICHOATERBEDT1—ZEMT S
CET. BEMRESHEERERTTEET . BEFEERDIL—V—ITEROHLF
1—EHTRENHLIHEEE. REE—FTEOIL—V—ITEEDOEERESFE
BML, FrL—E1—THERERICETIERICATEERSNIODOF1—%1
BLET . BER—CE2—ITUIYERLE, BBMICESTEERLATEEROE
KREDBITHNERSH. B EREROEHICATEOF1—NRTINFT,

FOR—THBAEBRDF 21— EvaOPIAVFINRD LI BEIFERICRST
BFREY 1 #U8—TEL FEEGEEINIERINOF1—ZEHT D5 E.
HREZBORITIZE TSR TERk, ERICBL I ERTIIEKBRELEZSINDGS Y
A—J T, Fa—MNBEPFHICRTEINET,

O, F21—5R)LIZT8val el 15mb 1%L DIEREES N BEIMICEMEN ST,
RRINBZF1—HERICECZ 57 95—T TEHNTLWVENIEA DN BKSIC
BOTWET , COKIGFHEEICF1—INILERRLUENKSITT BICIE, NFEA
73> (Engraving Options)IDIFa1— (Cues)IR—TIZHBIFH4—T D
$ (Octave transposition) 2T Fa1—5R)LIZEFELLY (Exclude from cue
label) JITEEELFET , Fiz. Fa—LICERICEREE LEETBICIE. TO/T4/%
FIIDIFa— (Cue)lJ IL—TIZHBTFHI2—THHFEFER R (Show octave
transposition) 17O/ T4 & ERALET,

SHI2, Fa1—F 1 DO FENULEDFAHEZ—TTHBHRASESEE. 21— (Cue)ly
L—TDTAH5—TL T+ (Octave shift) ITA/STF1EAUIZLT, LERIETFIZF
A—FBRASEIAVI—THERELET . F2—IRNILIH V=T DHANEK
RENTWSIGEE. CCTHRELEZBANRBREINET,

F1—DEWMERBDER: LEDAVRRYILAVID Fa1—NRREINDAV XY
IWAVREIF RSB TSN bdI5E . BEIMICF1— DRI EICLED 1Y
AR AURDBEICERTTHHMEESHNEASN, F2—DRTHEICIEF21—
DPRIRINDAVARYIAVIEREDERBICEIRT A-ODBHMERLEIEAS
nFEd,

Fa—OBRH B EREENSARET L. BELIRLAMEICEHEER
SHRESNET, F1— AU NOBIBEEN SMELSE, THEELS L/
BROEBTIECERIZRRSLET, (F1—RTHED, LEOTHIEBTS
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EOOEREERSIF. BEDEHEELSERLHEICRESNES )

BLRHEHREEERT AT — BN IL—LORYYZFCIHEE. FTLLVE
BOWBEVIZEEAZAV AL AVEDEREDE RS HBEMLEIZRTSN,

Fo1—DEMESEHLWVEERDE 1 FOEMICKRTINETY EISESPH

FRELHLBEE. ZRERICRTEINET).

BHOX 1N BETIEE. DEICHCTERERLEMERSNE T, iET
% 2 DOF1—HLELZHIZEL. F1a—DMRRSNDAIVAMYIILAVDEERE
BLB5E1F. BBEFLSIE 1 2ODOF21—ORRGEEIC 1 DEITRIRIN,
AEDEHIZERTZ-HDEHREIL 2 DHDF1—DRTHEBIZRRINE
T, X1 —MNELHYE. 2 DODFa1—H 1 DHEFELLIBEREZNELT 515
B.2 DODF1—DORBMEICERERRSMERSINET,

AV —rEYFEBREVFDOLATOMIMBRNDA T a 2R ET HE. HEIVER
INTBHREEE LEESTEHIENTEEFT . F2—DIRNILMHAFEFEIRL. 7O
INTAINRILDTF2— (Cues) 1V IL—T12HBTarH—kIL T (Concert clef)]
EARBRDOLATOMAVY—rEYTFDIHE) £EIBRIL T (Transposed
cleNIfERFDLAT IR BHEYFDBE) TANT(EHRELET . MBS,
ABEE. TILES. TH—REEICmMA. L (None)IZ:E&RTEHIELETEET,
[EL (None)lZ:&RT BE. LEDA VAL AV RD BT TIFEF 1 —MNRTRS
NBAVRARYILAVEDERIMERINET 2 DOFa1—HEEL. 1 2HDFa
— M F1—DRTEINDAVARIWAVREIZRLG L EHREEFERTHEEIZ. 2
DHDF1—DEEEBDOTO/TAHIEL (None)JIZERESNTVSIHEE. 2
—DRIRENDAVARYIAVIDEREDEEICEIFT A-ODEHMEEL S L.
1 DHDF1—DETHEIZRTRINET,

BEDAVARYIIAVRDERERLZEN., BIRSIN-F2—D/\yt—DDkd|Z
EENTLAEE . X1—NRTRINDBAVAMYILAV D EEIZTRMEINEE
Ao

LEDAVARYIW AV EFA—DRTRENDAVARYIILAVTERATLERHNE
BBHEEIZ, F1—DFRMEBICEED AV R IILAV LD EEICH T B IHERRL
EHRBEBMICEASNGLNKSICLEWGSIX, TEFEXF T3> (Engraving
Options) IMTFa2— (Cues) IR—U T, [Fa—FREDEIES (Clef at the
start of the cue) |Z F1—DRTREDA VALY IILAV D EEEREEEA (Use
clef of destination instrument) JIZZRELE T . LEDEREZFITH-HEETH. 2
FTICHRBALIZLATONT(ZFERT S BEICHLT, Fa—ILTEEE S
ERTTHIENTEET,

F1—ICRTRTDEELBEDER Fo1—(CKEDFEHREREHTHLTL—V—IC

9 R— Steinberg Media Technologies GmbH
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BEQERIAIMNYET, TN, Dorico TlE. AR E T —ITRTIND
SRS IR AT—. T—Tas¥al—Lar EME. BLUVEEEEDHELST
WET . R—HILDREEFT1—ITRTTHEEIE. AR ETCHADLRTINE
ERS

MR ECTXa—ICRTRTDRELSEEETHICE. FEATay
(Engraving Options) IMTF 21— (Cues)IR—UIZH A F1—BFFIZ[FERHTHE0E
(Included Notations) 1A 723> & ELET

Fa1—IRN)VFEFHARERIRLTTO/NTA/RILDIF2— (Cues) )T IL—7
DENSFEYETOANTAERET HET, Fa—BFICEDGESLESEHFERATS
MNEERICEIRTHIELTEFET

EEREEIX1—BRHICEATS (Included in cues) JICRELTEH,. IRTHDE
ERENFI—ICRRINIDITTEHBYFERE A BIRSN - F 21— DEEEFES
FTEERHICOHZUTHRERRE (REAEZRERTIL—NV—DE=ODRIAY
=) [F. F21—ICERFINFLA, Fa1—ITERTIESREFEHLICHE
AERT B EIFRBFATIEITEEEAD., FHRMICRESNDFTETT,

A TR ER DM pizz. | D KHEEREEE, BIREN-F21—DBEFOEHERNIC
REINTULVETAIE, Fa—ITERBENGDIEITTFELTEZEN, D1
ARH LAV TIpizz DB RO F1—DRABMAEKLVATIZFEEINTLSIES. F
A—[CERFRENFEE A, COBEREF1—(CEDDIFRELTIE, F2—0TBIBRT
FRAb (Start text) I TANTAEESHMZ ZIENFEFOLNFET, RERIC. R5—(FF
DEIAMB LR TREBMNBIREIN-F1—DOEHFOEREICEENTORITAIEL F
1—[IRREINFEA,

BREN-F21—DEFOHAREZER: NPRETIE. ERIN-F1—DEHF
X 4 5D 3 OREFSITHE/DNEINTVET  ERSNF1—DBEFOHAIXEE
BYBICIE, [%&AF T3> (Engraving Options)1DIFa1— (Cues)]R—T T
[F1—FRHDMEE (Cue note scale factor) JZEELET,

F1—INIDEE: Fa—DFARMEDINILIZIE, LEDAVRRYILAV DA
BN A CTRREINET . AV AL AVNEERE I TR RSB ZIGR(E. [
EA4F 3> (Engraving Options) DI Fa— (Cues)R—U T, [SRILIZERTR
ShBLVRRYILAVRE (Instrument name in label) 14T a3 2T IEEX L #HE
A (Use full name)lICEELET, #HARE TIE. 1V RR9ILAV D FEFRE
YFEIRIVIZRREINER A BREIRNIVIZEDDHEE AV RMIILAV DO E
FBFEIE#E (Instrument pitch or transposition) 12 Fa1—5RILIZET
(Include in cue label)JICEELET,
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FF2—#&HYNEBMSN/L (Additional label at end of cue) 1A T ar MR DE
ZRAREEIZIPlaylZR < (Show ‘Play’ at next entry) IIZERESNTULVSIHEE. ¥
1—DRTHEIZPlay I BRIRENET, Chld, Fa—&—EIT/NEIRFFERTL
BWIEDHIO Y ADRAI7 CHIFERAINET,

F1—NEBDAVARIIAVMIEHATAZY VFEEAV2—T TEEINDS
BLRHYFETH. COSEEMNAZREDF1—FBRMEDINILELEELT, =&
ZIETVIn.l & VIn.ll collottava D KSITRRTEET , CNFTHEIICIE, F2—DF
RIVFELIEHAREFIRLT, TONRTA/RILDIFa— (Cues)IT IL—TI2HB
BAtA TR (Start text) | T O/8T4EFIZLET, BEHkIC. T TFHR+ (End
text) | T O/RTAZFUICLT. SNILDER T HLEICTNILARTSINBEWVKRTEHS
RVERTIBDIENTEEY,

F1—INIVFEARET. F2—DFEN LAZTDHE (BLUF1—(EFED
NEFENZEE) FEROLIC. F1—DOHENATHEDHEIEHERD FIZKRTRS
nEITH, [EBEA T3> (Engraving Options) IDTFa— (Cues)IR—TIZH
BIE1—5R)LDOEIE (Placement of cue label) ITHREFZ LB TEET, 1=
TRINNTANRRIIZHBTF1— (Cues)IV IL—TDIGIE (Placement) 7 A/\T
1%FVIZLTEEICTE (Above)IMTTF (Below)JIZT &, Fa—DREEER
[CEEETEET,

Fa1—DVALIZKBAR—=L VY Fa—([FEBE. F1—DBRRSNBZIVRYIL
AUPDEEDEEIYIAR—D T HNPGYET . F2—DVRXLIZEDHAR—
DUTNED SIS ETHEEME,. TLATIA T3> (Layout Options) | D
[BRDAR—L2% (Note Spacing) IN—UIZH B F1—BFDAR—I 2T
(Scale space for cue notes by) |4 T3 TRETEE T, -, BEDEHHIZIF
FDAR—US MDZEE (Note spacing change) If AU hEFEALTEEET S
EHTEFET PR ETIE. F2—DUXALICKEZERMGERAR—2UT &, 70%
DHBINRIZIZH>TNET,

Fa1—%FRTRITTS BALTL—V—DEENERDLATIFTRIRENDIEE .
ZOTL—V—DEENRREINDLAT I LIZE LGS Fa—2RRLAETNIE
BoEWNMERELHYET .. COLIGHE. F1—EERLT,. TONRT1/RIILOIF
a— (Cues)IVIW—TIZHAHIFERT (Hide)ITANTAEFUITTHET, ERI
[CF1—ZFRRICTEET, COTANTAE. BEDLATIEDF1—DRNEE
ERTRIZTHELENTY,

AT arnEE: T[Ea— (View)] » [¥a21—%348 (Highlight Cues)lE. ¥
—IRRSNSUEEZFBADEBNERTHRIAL. F1—DHLLLEEFDAL
B+ BHOFTVVERTRALET, RREMHE/NT DIZERARITELGD=H. E
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G steinberg

CIZxa—MEBMEFEAFEZDON., EQAVARYIILAV IR a—IZERIN TSN E
— B CIRETEEY, ST, DRI PLAT I REFX YL —E1—TRTT S
ESITERITY,

TEa— (View)] » IEFEAFDHS— (Note and Rest Colors)| » [Fa1—
(Cues)ll&. F2—DBEFEIL—THRTRL. COBRNEERE TSR LEMS
#F7,

24H)Y

SEDT7YITT—FTE F—HR—F, EEEBREIVRERDIAVVTEHR
—b; ¥ HEBRSNIRENRESNFEL =,

E] 3 i =
._:_;5; atims j;:,-ll;:;f.s_;.J ;Eg&'gﬁ.i

T4VAVTDARA: T40H) T (3B R DFFEICEEM T oS0, FFED
AT EEBMT B ERERRT DLENHYET . I—FOBRE T NTIZHY
BTV H) T EEBMTBIZE, ET A FDEBREIRNTERRLET (B
BENRTHAHEEVIVITHEREGERTHIENTEEY ), 1A T %
EBMYS5EREELEE—FTERLT. UTOLWT A DERELITEVNET,

o [Shift|+[FIZBLT I« HYLY DRy FA—N—%EK
o [E2EE (Write)] » TD42H) T %4ERL (Create Fingerings) 1%:#R¥ 5

o AR DOABIDREEY—ILRYIRIZHFHLOGEMShT: B REVEH )9
ERS)

D4VH) T DRYTA—N—BRRENEZDT, L TFDHETRRESED TV
VoJEANALET,

o BHOBIREERLTWBEGEEIE. 240H) %I TRY-TI1,3,510
FIINTAALET . F—R—FDIHE. BESDIEFERICTILELEHYEE A,
Dorico Tl&, 1B ZELDNEFNEFNIR-T. FESH BEIMIZE LB
BICHUVBAONTETS , COBRBIEELGINE E7/EBROLEFTHEF T,
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TRIFEFTERYHENTHRELGYET,

F— R—FDTVHIV T NERELLDFIZKEED M ERREICIEET SIS
E. XD ITAHI T DRIZEFTHNILTLI. EF THNIETRIZEML
FI(EFEEREITHEE. FEED eft)IZdH=%Tgauche DTG, lsinistra
DIS]. TizquierdalDT1. ZL TN E IOTHILERTEE T . AFZIEET 515
B & EEND rightlIZ& 1= droit]. ldestral., lderecho DIDJ, ZLTIA]
DIMILERATEET,)

1 DOBEHFICHLTERDI«VA) T HIEETHELTEFT FEAIEE
IWTUROA—2DESREME I T 27100 T EIBET HEE . XY
XFEANT HEHLI=HFE2343 1D KS3IZAHALET,

RBRBOREETE., BALE (ZLDEEEFHE) " EROERDERIZER
ENBHEENHYET, Dorico TIE, RLITAA)U T ESEMRIETS 2 2D
ERIHEET ST T [BEF T3> (Engraving Options) IND R E ZHE>
T 1 DOI4H)VTBEBITINSEAITENMD LD T4 H I TEEH 2
ERREINFET,

RETAAVUTE T4 AN TBEEDTCILAITHEI (RIHAERE) F1=-
FABENMTHENTRRINET . RBE 71V HI) VT EBET HIZIE. 12(3))
DEIINBED T4 A) T EBDTCILAICHEINTESEEHATRY T4 —
IN—IZAHALFET, HEEA T3> (Engraving Options) ITHRE 14 HY S
ZAENTRITALIEELTVDIEETH. RyTF—/N—ICANTBHLE
FIENMEFEATILELHYET,

WEEICKDTAAVUTEATEN (EAKE) F-XENTEHERTRRS
NFET WEFICEDTAHI T ERET BITIE. T4 1DOKSIZAIFENTE
BEBHATRYTA—N—ICAALET , EFICIE AZEDT AT DM
DYIREZICKZ TV AHIV VT RRFTEINET,

BAleLlL. BREHDIETERLTH L., BEHELLFEMDIBITHEDHLH
[CEEMAIBEEZEVET . BRAIEZIEE T SICE. 1 DHE 2 2HD T«
DHITEBENATOTILIIDSSIZRUYFET , CNITEHTICIZER
BAEREINET A, HeENDTaAL—avEERTTHIELTEET,

BREBRDTVHI T TR TIZEAALTRIEDIERESTERTRTHELT
EFEJ,

EERBDI(VA)ITIE. NIVTEE (FSURY RILUIEE) PORSA
FROLay (bAVER—U%E) X —FR—FDT740AV T ERILAETAR
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TEFET RATFARROIIVAIT.HFIX 7 FTANTEET,

BIRU-BRERFI—RIHTET7000) 07 DA NZEET $5HIZIE. [Return]
EHLTRYTA—N\—2HEESEFT,

T4VHN T EBMY BT, RICERERRITDBELNH D=0, KyTAH—/1—
ABFITRODEFITEL ZEEHYFER A RyTF—N—2HESELHEF. K
¥ —TRICHEETHN. YOVRATROEFF(Fa—FEERLT. BERYTH
—N—ZREFET,

T4A) T HERRTDLATIRDER: DHRETIH. T40AHIVTET)LRT
TEN—FLATIOLDEAIZRTEINET, LMLTOD IO MEIZL>TIE. 7
ATV T DBRFREINDDIETIVAAT EIE/IR—FDOWT NI DHTHDHHE
VBB EEHYET TaoAV T ELATINMIRTTENEINE. TLLTIME
7Lay (Layout Options) DI FL—¥— (Players) IR—J(ZH BT 742 H) Y
5%R~= (Show fingering) A 7L av TRETEET,

TAVHAIT DRE: BRITHTONF=D40H) T EmET BICIE, TFEER
LThB T4 AN T DRy TFH—"—%EE ([Shift]+[F] £#I4E), HLLVI«
VAN T EAALET Tk, TORTFARILDI D4 H) T ERS a0
(Fingering and Positions) 17 IL—F12H AT 240 H) T FE = IFRO L ay
(Finger or position) IZ7A/NTADIEZEE T D ETHRETEET,

TAVHIUT DEIRR: TEE—RTIAUAIVTEBIRL-EE . EHLRBISE
RENFET, T4V AT IEBRO—EHELTHET B0 TT, #>T. T4>HY
U %ERLT [Delete] #RLTEH, 4o HIV T DHEETEIELTEFEA O
HYIZ, EFZRIRLTHS., TANTANRRILDI D4 H) T ERDLay
(Fingering and Positions) 17 IL—F12H AT 240 H) T FE = IFRO L ay
(Finger or position) IOTANTA4EZAIIZLET . RED T4 H T ESNEMIC
HIBR 9 BI2E,. TOvoBIR GERD 1 DO/INEFDEBAEHES) VLT, [Shiff]
LA DY DN DOZEENZEY)vY) 170 TR (Edit)] » D¢
JLA— (Filter)] » TEHEMET (Notes and chords) JZERAL TS H LS DREIR
5L 240 HBYTERIERISS 3> (Finger or position) IO T /T 4ZA D
[CLT. T RTOBREZ—EICLELET,

BZle BREHHETEERLZHE. BICENGWVVETRHORBICESTRASILE

$eRT BIZIE. [Shift]+[F] TRILV =Ry TA—"—I2. 2 DDOT«L BT ENA

IUTRYDTI2-BIDESIZANLET . ANTHEBZIEIER SN, T4V
THBTHABERD LN TICHRRFA CRESNET . BRIBEORTRIZOVTIE. 7

AVAH)T BEDRIHEBERES KD, ENTICRS—%EBNE. [HELA T3y
(Engraving Options) 1D 24271)24 (Fingering) IR—C GERTEE T,
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G steinberg

BRENMNECTHEEZEADIIBEISIERIL. ERSN-BZIEEFERTEET . C
NIZIFLUTOVT D DIEEEITEVET,

o HHEET—NFT.BABEYIATEIRT S, (BABOERI—IOEAIZHZD
AVHN T DEICHWNVRILARTRENFET . BRAIEDREEZEETBHIZIL.
HAWNURILEERIZESYILET,)

o EE—NFELITHEEE—FTERARERRLC. TONTARRILDID40H
oG e ay (Fingering and Positions) 17 IL—F(2H AT & ZEDA D
2wk (Substitution offset) I 70/ T4EAVICL T EXZEEBLET . 1 O
DIE. ZRYDITENSBAIBETLEOIFETORSE. 4 HERAMER TGS
NTERHLET, COHT. P THEETEET .2 DHDEL. EHFFFTE
ALV RETLILDIERALET . BECDELXRETILEEHYEE A

ERSN-BAEL. BISEBERTRREINES . BAEAEHFOLTDRAS—T
RTNSNHRETLINIEIFEHRTY

ERSN-BARERFICEETHEDMDTAAH) T (E, BEYIFIEE TS K
SICBEEMIZEESNE T,

HUTHIUT BU T4 AT RO BB THRESNEZI40HIUT B,
BYKIT TS EFICERBRICERINSGILE BEEICHSEI=-HIZERASN
FT BRI T4 AT E BT IREIEHYVER A EIZT1oHIT%EBMLUTZ
BRDPELBYFEVDTWBEHEICHD I AT HEMT 5L, ZIIZEBBIMIC
BUTA) T HARRINET , DR ETIE HU T A) 7 (F$ENTEFE
NTWET  RUTAVHI T ITHENERTEIELGIMEE L, RRETLEITHT S

ﬁ[i\

[%EA 723> (Engraving Options) 1D 7424124 (Fingering) IR—2 1285
TR 742 H1)24 DFE] (Cautionary fingering appearance) 1473 &% EL
9,

TAURDZFER: NEPARETIE, T42AV T IERFOO—T T4 BFREE
DEFIZUU-NE) TRRSNEFT MDD I+ TRRSEDGEE. [RELF T3
> (Engraving Options) DT 74> H 124 (Fingering) IR— T 242 AU 5 D
5\#8 (Fingering appearance) &2 (Plain font) JICRELET . COHRETIE.
T4V TES . BB IVARBIMDORTRICE, D420HV T ATHFRAN A
b (Fingering text font) JICERELI=TA R REAAMILOMEREINE T, HIEDIERE
F. BAEOEBRERT— BLUEEERORYYNFORREIERINFE
Ao
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EREDERME: RBERDEFS. VAT EEFOEROLELVEFD
BOTICRESNET . ZERBLIVEEERDEE. T10HI T LEICERD
LIZRTSNFETS,

T4 AT EERIZ EROMEAZRELEFRDOLEICERET DG (L. 71>
HIVGBEBEELIETOHI T DN EEFEERL. TO/TANRRILDT 240
HYL G ERSL 3> (Fingering and Positions) 17 IL—F(2H A EER ED XL
B (Staff-relative position)1Z#4ICLT. BEIZIGECTIE (Above)lF=(EIT
(Below)JIZERELFET

BHRERLEDREETIE, T4oHIV T FERNIZ, EROFELALAEZTHN
FEROLIC. EROFENTRAZSTHNIEERO TICRESNIONEELLVE
BIHVET . ZDOLIHIGEEIL. [BEA T3> (Engraving Options) 1D 7425
)24 (Fingering) IR—U TIEERIZHT 2740 H) T DALE (Position of
fingering relative to the staff) 1ZFEERDAEFIZHES (Follow voice directions) |(Z5%
ELET,

RS—Ix T BAE: FHARTE TIE. T420HIU T IERS—DIMOREICEESh
FIN. AS—DBBMBEER TREBEOANMIIZERESINET . COMIARE L.
[%E&A T3> (Engraving Options) DT 742H1)2%" (Fingering) IR—2 Tl R
S—. A V=T EFIZxT B T740H2T DEE (Position of fingerings
relative to slurs, octave lines and tuplets) |Z & E T A EICKYERTEET, 71
VAT EEANCRAS—DIMUICERE T DIGEIF. T4 HI T BSEET T
AT DN =BEHFEZRBIRLTEEE—RICAY, TANRTFANRILDI D007
J &R 3 (Fingering and Positions) |7 IL—F TI RS—ED L E
(Slur-relative position) IO FO/\TF4%#4>IZL T, M4M8] (Outside) IICERELET
AS—ORARIZREIND T4 AT & BRFESLUVAI2—THRIZHLTEHRAA
[CEEINFTH. RAT—DRANBLIUVREDEFOAIT. EROFEHEILEIAT
DNEIICEEBESINDZEISEELTESLY,

TAVAIVT DEBEDRE: J40H) T F FEE—FTERLT [AlY] ZHHL
EALRHF—THNYT LT MEZHBAETEET, [Ctrl]] (Windows) +°
[Command] (Mac) #ILEALXEF—TENT L MEF LY REEIETIHET
EFETFTAUAI T EIVRATERERN Y THILLTEET . HHLE. TO
INTAIRRIDI T4 H) T &R 3> (Fingering and Positions) 14 )L—7
[ZHBIATHyk (Offset) ITONTFADIXIETYIDIETRHEST 2L TEET,

TA4H) T BEDREE)EYNT BIZIE, B EE—FTI4UAH) T EZIRL,
MR (Edit)] » TR 3V %)Yk (Reset Position)12£173 %h . [0ty
b (Offset) ] 7A/NF4ZATIZLET,
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NWILVTKEEREBZDI«OHIVT: SRRV D KSERIETIE, 407
Do FERALTHEEDBEEHTOICHEZ /LI ERLET LK bV
RYLT C Ir—TEFEETHICTIE. 1 BE 2 BNAILITEBIZIBENHYET,
h#E [Shift]+[F] ORYTA—/N—ICANTHHEE, BIZT12]EAHALET . W18
BRETIE. EEEBRDOIT AT (EME 1 FlIcR TSN, BEOREICIER YR E
ASNET, Z42A) T DHUERE 1 FlICLizY. RUIYXFERS Y alZLE-
Y. HZLICLI=Y T BICIE. T EA T ay (Engraving Options) DI 24241
4 (Fingering) IR—CTI&EX38 (Brass)ltoiav DA T avEEBRLEY,

EERBORSARRIL I AVR—VBEDRASAIFXEERBDRSARRY
DAVERTTAEE. TIETHENMMA—IHFOVWTIAMEFEALET, WHI%
ETIE RTAIRROLIVICTIETHFENRRSNETN. BEA T30
(Engraving Options) IMT 7424124 (Fingering) IR—C TN bAVR—U D RS54
RRI L a> 4188 (Trombone slide position appearance) 1% O—<#=F
(Roman numerals) |IZERE T HIET, RREO—IHFICERTEET,
[Shift|+[F] DRV TA—/IN—IZRSARRIL3VEANTIEE. TISETHFERE
ALEY ., AA7ICA—IHFZRTSEHEETHL. ChIFRERTY,

RILVDXEDIETRES: FTINKRILDEEX F EFf=IE BbE (FBICh)T
IWRILDIGEIETIVE EbFEIE F B) O3bENEZERALTERI HNENE
RYEDIT RIL DIV A) T IERT AR EEIE R SEBETFAMATIT
HIGENHYET EAICI>TIFEICHRIEDITIZRTTEHLDLHYFETMN . EY
FERET DILICES T EDXEMNMERASNEIRNENTARKIIERT H5LDLH
UFET, XEDI/RIEEEEMTBIZIE.F ORILY (HDOFREDOKRILUIFRED
LEAYR—FEINTVERA) HNERTIEFFEERL. TANTAIRILDIT1>
HULF ERTL 3y (Fingering and Positions) 17 )IL—F12Hh A S5 5%58E
(Horn branch)17A/N\F4%&AUIZLET  1zZL IBELE-RENERLI-BFIC
ERICEDNTHANEIHDDHIEILITHEONERE A, CNoDIEREEE DI EIZH
$54+ T aviE, %84T 3> (Engraving Options) DI 242H) 4
(Fingering) IR—2IZHBITLUFHRILY (French horn)1t9arTROMNYFE
ED

BRERDITVAIT DT BERTL—V—D . HEHBELIYEL., FIEED
BERICLIAHI T TEET 2012, BBROEBRLETRDS L aVES TN 2
ENHH5E. BIRLEDEBEDAMEZRT RODBETRHOINIZENHYET,
CDBE. BREERTIREHRELTHS, TANTAIRILDI 240 HIITER
£ 3> (Fingering and Positions) 17 IL—FIZH AT RDEHFADL I EIET
(Indicate shift to next note)I7A/TA4ZAUIZT BE. T4 HIYL T L TRDIER
BEERRTEET,
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BREERTHIRETIEET DT REBN—FOEFERERL, T/ Ta/3R)L
[T ERFFEART (Notes and Rests) 17 IL—TIZFHLGEBMESN =% (String)17'A
INTAFEFAUIZLET [ (String) 17O/ TAIZIE, TDEBTEFDEHEEET
FHRLEITHEYFELEELITRREINST-O. ELWNZEHHIEIRTEET, %EiE
ELEHEICERDEYFERELI-CEIZKY, FBELIZRTEYFEBETELE
SfmE. TANTAIEBEMICA IICHYET,

1 26E 2 DHDEFRAAISKEZEELTHL. [ ROFHFADIINEET
(Indicate shift to next note)I7A/ATA4ZAUICLET . 1 DL 2 DHODER
DOEAICBHREICToH) T HRRLUEGLTH, VIMEREE IR TEINFET,

[%E74 73> (Engraving Options) DI 742H )% (Fingering) IR— DI3%
BRIZBITE740H)25 DTk (String Fingering Shifts) 122 avIZlE, Ik
IEREENDRES.AS. AE.ZLT 2 DOEHRBEOMEICETIRELHYE
ED

RRSNFZTAUHI) T DIOITNMERESH . RRLFEWAREHEICLGEO>TLNSIGE
(X. TS 2RAR (Shift direction) 170/ T4ZFVIZLT, Y IMERIEED A EZE
EHIRICEETEET,

MusicXML DFEA+AH: MusicXML [SIEFRDFETI4 AT HEESNTL
51%54a (fingering BERFMERAT 57LE). Dorico IZHRARALTEMNTEET , 12&
ZIX. Finale Mo>EEHEINT- MusicXML Z7A)L(F. BEELWAETIAHY
DU MNEFHINFET A, Sibelius TIXZSTIEAL=®. Sibelius MHEZHIN
f= MusicXML 774 IDBIET40 BT %R AL TEIETEEE AL

WEEITRBORH

Dorico 1.2 Tl EEFEITEBDEELBENICHR—FT AHEENEA IR T
T, F-. BHDA VR A D EEE T YN AA T, SESFLLAT
DR CERBRRETHSIFRLGA T avbmEATNET,

HMEE—FR: |BEEITEBOAVRAIYIILAVMNE, BEEBEBFERRICTL—V—
[CEIY L TRHIENTEET , TL—V—ITITEBD AV R ILAV IO EEREY &
ToNTWAEE. BELTREITEFENTNTN 1 KORLICRIRSINET,
rTLAF7 AT 3 (Layout Options) IO FL—%— (Players) IR—U Tl
ARYILAVPDEEZEFFA (Allow instrument changes) 1A 24> TLNVS15
BIE. TL—V—DEETIRVIDAIVALYIILAVCDERIZTINRRSN. B
FREBLEFAK. ERNTAURMY LAV D UY B Z N TEHONET,
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TL—Y—IEY LY TON-EBROESEITE
BDAVARY IV AN ERIFFIZRRT HITIE, T
BRI VNHERTOILENHYFET HlELT.
FoLEYMIITERFIEND 1 FETT FILEYMIEBROMIILIZESRZMN 1 D
DIL—LIZFEDOON=EDTT, BEIFIZED 5 FELELICRESh ., FRBEN
EREDERNDMEICRRINET, £ HEOFENMEASINIIGEEILHYE
T, RARIC. 1 HORUTE 2 DORVTRS LMD DITESEIFVRELTHIRDAL,
BE 2 SOV YRFET, INSWRUTN LD, KEWRUI N T ORI
nFEd,

HEE—FOTL—V—/RILTITEBR DAV ALY LAV EHEY B TENT
WBTL—VY—DHh—FZERHETLHE. ITEFTVNMIRB TR RSN, BRIDITE
BDAVARYILAVNEIMDFEFED AV Ry LAV RERRR, KB TRRISNSDMN
AMYET,

BRADAD ALY ILAREITEEE T UM TL—N—ITHTEBD AU RS ILAVIH
BHERZBYETONTVSEE. RRAEE 1 BEOALLGVET ., Z0TL

— YV —DARREINDTRTDOLATINT, TENTNDITEBRDA VALY ILAVD
AMAaD 1 FEIZEESA, BAHOSNILNFFONEST, TL—V—IZ 1 Dh 2
DIEEDITERDAVRARILAVIDEY B TENTWSET DB EIERTIAT

N 1 BETLHEOYETA TNLUNDFZE X AV ARIILAVREAEHE
TEINERR T BHIEIZELT,. ZOTL—V—IH T EREDR T EZE LY
[CERAETEET, FVMEFERTHE. JUYRE 5 REEELD 2 DORITRAENE
REE(CIDHY LAT IR EICEREEEZALNDIED. TL—FY—DA Ry LAY
MIEBDINIVEFITHIEMNTEET,

BERIDA VAR IILAVNTERYRERE: TL—Y—(EBDITEIZD A2 R RY)L A
VR 1 DUEEYETOENTWDIGS . ERD AR AV NERAEHET
N=HyavFyhERTEE T N —hyiarFybERmE T HIZIE. BREE—F
TIL—NV—NRILADTL—N—DH—KREHI)YILT AV RMYIILAVNTF
yhERAL (Combine Instruments into Kit) 1Z:#IRLET, ITIZ 1 DULEDIT
ER I UMTL—Y—IZE|Y L TONTWSIEE X PDOFYMNAEAR DA Xk
GILAVNEZ DD TV A RAENET T, FYMNEFEELLGMEGEE, FLLFY
Y 1 DIERENET . TDHE. TFTEBFBFYMERESE (Edit Percussion Kit) 14
A7RTHERE ERESN=FIrD ., 2EXIETVYRO 5 BREICEITHAUR LY
WAV D A WIRGEERETEET

ZEDITEFJIVCDER: EDITEBZIVNETL—V—(TEBMT BICIE REE—
FTCIL—N—IRILADTL—Y—h—REEI)vIL T, BDXYEERL
(Create Empty Kit) 1&ZIRLET , T7HLMITRBFYLEE (Edit Percussion
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Kit) IZF 47T W EE ZOITEBRFIYMIAV R ILAVIEEBINTEET,

TL—Y—RITOITRBOAVARYILAVCDBE): ITRETL—V—DRELFE
ELF=HET. TU—NV—RBITAVARYILAVNEE|Y B THEETRELNELT-5
B . REE—FCHEICRETEET,

BRI DITEBDA ARSI AVSETL—V—RETHET S EEREFIE
BEHUVFE R A BINLEVAV R ILAVIAEIY B THN =T L—Y—h—FZEMR
L. AV RARSIILADRED )L TRIZHD TL—Y—IZRSv T 950 1V ARyl
AVRDIKBDIRILDEIZRIRAA—YIIVEBELERTEIND>120)vILTay
TXAMMZ2—%FE, YT AZ2—DIAV AR LAV IETL——IZBE
(Move Instrument to Player) IDSBEIED TL—V—%:ERLET,

BT DITEBOAVRARIIIAVINFIRD—ETHIHE (X FTTEFDIURE
YL AV ETITRB I VNEHRE (Edit Percussion Kit) 1447045 AT, Fybh
SHIBRT ABENHYET  FATATERKICIE. TL—V— /S RIILTLU Ry ILA
VrDBEDIRILD LIZRIRA—Y ILEBLERTSNE> 120y TarvT
FRARAZ2—ZFFE. [FTEB/ I VIERE (Edit Percussion Kit) IZ#IRLET,
DT —N—ITBESE DAV ARYILAULE, FYNHD AV ARYILAVEDY) R
tovszRL B 2oyvsLTrornbBIRLET . SYMREBEEEFCS L. B
BRENTFzA DR IILAUKE, TU—Y—ICBTHER DA RAEHILAUREL TSR
RN, COFFMDOTL—V—ITFSV T TEHLEBHTEET (BLEICELT, B8
EDTL—V—IZEY L TONFHRELIBRFEOTYMNMHRAL LI TEE
EDE

HEBRDAVARYILAVEDER: FHEE—FT. AEEERODAURMYIILAVE
thDEEREBRDAVRMIILAVMNIERTBICIE TL—VY—/RIILTIL—F
—H—FZRRAL. A1V RAMYILAVRDIKBDINILIZIVRAA—YV ILEELER RS
NBM>1%0)y L TaAvTFIAMZ2—%RE A1V AMIILAVIEER
(Change Instrument) 1Z#IRLET, COAVRRYILAVNZET HEED (T
FTRTCEEEDAVARIILAVRTREFENE T 1L ITTEB DAV RXby)L A
VNEERTRHIGEE. PLEBENEDYET,

FT . HERTVMIMMDEEDA VAR IILAVKNIERTHILIETEFEH A ¥V
P @FBEDOSNIL) OAVTFAMMZ2—2HWVBE AV RMIILAVNEER
(Change Instrument) IIEEIZESCHOTNVET,

=L, BRI DBEEEITERD AR LAVNE WD E DEZIEITESRD I
ARYILAVMIEEBRTEET [/ ARy ILAVREZEE (Change Instrument) 1%
BIRTDERYTH—N—HFEE, TR TOESFTEEB/IPRTINET,
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HEFZXIMDORREAT: IN—HviarFyMIBTHEEIE 3 DORREAT
MOESRIENTE REICIELTIOD I IMNDLAT IR EICERRDIRTI(TE
FERYTEHELTEET,

o 5 5 (Slinestaff): 1 FRD 5 HELIZTRTOAU R LAV —H#EIZ
RESIN, ThENERAOHROBE(ERMICBIY L TONET , KRAICITEHE
RINIUD 1 DEFRRSNET Tz BRLDTRTDAU ALY ILAV
FIFHEORA VN TRESNE (VAR LAV DHER T HITEBEOL
DIVRERTTEFY,

o JYK (Grid): EAVARYILAVEHMERIDS A LIZCRRSWETH, B
HBEVRFREELELEERLLOERAL. BUTHNIELEIZELT, 512D
FTCLEFLETCTORR—RICERERETEET . JUVRDIIVITEE.
AR—=R 2 DHH 3 DR OERTREINETH. ITRXTOSIUDOREREH
ZLLGDIBEIEIHYFELA TUIRDERSINIVIERRICHRE TS, BRBTE
[ZERMDIRNIVEMTDHIEL BBDAV AR IARET L—TELT 1 D
DINNVE[FITHIEBTEFET,

o FEBDAUAIYILAVE (Individual instruments): &A 2 ARSYILAVSHE
MDA LIZRREN, SRS . BFELELELRBICHLGET . BUTH
NIEBBIZIELT. SIVDTCLFEETCTDRR—RICEFERET S
EHTEFET ALTL—V—ICEIV B TONERD AU RR9ILAVRE T
AT I AT 3> (Layout Options) IOTEBEARDAR— Y (Vertical
Spacing) IR—C THREL-HRELGHEROEEICH > THENGNET,

4 DDAVARYI AN EDEFVNCEETDIRILEEE . TNTNDORTEIA(T
TRRLE-SEEDEELEFHZELUTISRLET,

L Clash Cymbal y Jl 1
Percussion y  — I'riangle I :
— Snare Drum J
Bass Drum J
5 S
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Clash Cymbal

Triangle

Snare Drum

Bass Drum

BRID A ARSIL AR

RRIMTDERBIL. TLLF I FTLar(Layout Options) IO FL——
(Players) JIR—ITITIEWNVET , [FT83% (Percussion) 1o avIZ(E, #IRLT-
LAT IR THREBIVRDA VAR ILAVIREY B TOEN TS TL—Y—T¢IC
REVDIINRTRENET,

Percussion 2 | SlineS2aff | Grid |EESHEHE ISR RIS

TEBTVNORE: FTERTYNERET HICE. ITERXVMERSE (Edit
Percussion Kit) 1A 7RJ #ERALET , ZOFIYNEERT oD 1Ry LA
VrEHABDOETEYNERATRE. COFAT7OS NEEIMICEBEEET, BED
FIRDAV ARSI AV ERET BICIE HEE—FDTL—Y—/IRL T, Fvb
MEYETON=TL—VY—DA—FZREEL. MEDINILITTIRIA—YILEEL
ERTFREINDB> 1 ZV)VILET , RRSNIZOV TR R 2 —THITERFYNE
#RE (Edit Percussion Kit)J#ZBIRLET , L TDLSLEF (7 OIT DRRINE
ED
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© D Edit Percussion Kit

Name: | Drum Set Shortmame: | D u Drue st

m Grid  Single-line Instruments
Solash Cymbal
China Cynbd
Crash Cymbal 2
Crash Cymbal 1
Hi-hat
Rde Cymbe
Tom-tom 1 Conbell
Tom2om2 —~ Wood Block )
Snare Drum

D Wood Block 2
Tom-4tom J
Tom-2om 4
Kick Orum 1
Kick Drum 2
Hi-hat (pedal)
Move: Stem direction and voice:
+ 38 i

475D 1 BFEETIE, FIYMMURRIIAVIDER BB IV ERBERTE
TEFET . ABEIE. .5 BEDRTRIATEFATIRICERSIANILELTHEASL
ij—o

FATAT DAV DRETVTIZIE 3 DDITHHY.3 DDRTIAMTENEN
[CHETEFVEDHNEERETEET .

5 &5 (5-line staff): ETV7OERICHESABSIXERMEBICHELET,
0 OIIEIE 5 #REDFE 3 MHVET (MERLRSEFEHATHERTIE B4,
ANBRBEFEATHERTIE D3 OHEICHYFET), -EZIX. 1 OEEFXSE
3MOFTCLOM (5 3 ). -2 DEEXE 3 MOTOR (F 2 ) TY.
ERD 5 AORIFEVKBETRRIN, EROLTOMBOLE LT L—D
BCRTINET . TNENDAURbYILAVMEHER EOER DLLEIZR T

SINFT AR LAV DERBEZEBESEBICIE. BICKSYIT7orrFAYyT
LET . BHEODAURAMY LAV RILERUEEZRETHELTEEFIN. &
AVARG WAV TEGDFEEFERALTRALPIKTHIENEELINTT,

1)k (Grid): ETUT7DERIRRINDIBFIE. BRAVRR9ILAUED
SAUDERELRDAR—RATROLTWET PR ETIX. JUYFAD
FTRTDAVARGILAVMIRAR—R 2 DHDORBIRIZESTOES . fRETY
FIZRTREINDA VALY ILAV DI VIEIL, T yRIZR RSN D VIEE—
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BLET IBBEEETDICIE AR AERIRL T RETV7 THD
T3 n—IH A8 (Move)lD ETERENARAVES)vILET 1V R
HILAVENDERD AV ARG LA ETORIREEET HICIE. LAIDAVRE
YILAVREERLTHOG IRETV 7 THOT I avN\—IZH SR (Gap)l
DIEFERELFET  MHAZETIE. TVIRHDA VAR ILAVEDIEERTNIL
FZNZTNDRLEIZ 1 DFDORRINFETH. BEYESAVRAMYILAVES
IW—TELTIRNILETE 1 DITFEFEDDIIELTEET . VIL—TEERT S
21X, BRI BRI DAVARYILAURES )Y L T, [Shift] #RLEASLE
BODAVRRYIADREG)YIL, TOaAVN—I2H BT+ IRV EBLET,
TIN—TDERMELERTBIZIE. TIL—TEERT DAV ARILANEDE
BIOIT LRICRRSNZAREZT TILI)VILET,

o 1 REEFATBIUAIYILAVE (Single-line instruments): #RETV7I
FFTRTDAURRIILAVED ROATIZRFEINDIEBZET)RANRRINET,
IEFEZEETBICIE AR AV ERRL T HRET) 7 THROT I3y
N—[ZHBBE (Move)lD ETFXRENARZVED)VILET,

AVARYILAVCD R ERET DE. TRTORTIATIZETHNEBIZEELE
T, BHIERET BIZIX. 7H2avN—DTOIEZRTZIRE (Edit Names) R4
#=7)voLET,

FAT7AT D—BTIZHAHT AV N\—TIE. I RTORTIATICEAINDZ
DMDBRELITEZAET . 73V N—TIRASEDMDIFEEENLIEIZERA
Lij—o

+ 4 0 []

o HBAVARHILAVREEBM (Add new instrument): FYMIFHLGEMT S
BERRITEBOAV AR I AVNEEIRTEDRY T —IN—%RRLET,

o TL—V—HIoBREDAUARYIILAVIEEBM (Add existing instrument
from player): ERIDITEZDA RS ILAVE (FYMIADTLNVENAUR
koL AVR) BEIY L TONIDTL—FY—F A2 —IZYRRRTRL, DT
L—Y—olDFyMIEBEI LAV R AVNERBETEET,

o XYMBAURRYILAVIEHIER (Remove instrument from kit): ZEIRLT-
AV ARGV AV NEF YD SIYRE BRI DA XYL AV RELTHID T
—V—IZBELIZY. DX IRV A RY LAV M HRAATZY TESDKSIZL
9,
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o AVARYILAUREZEE (Change instrument): Ry TFH—/\—%FAE, B/iIR
FOAVRARIIAVNEBERZDFHLNESERERETERTEET ETOR
BIERBFINFET,

o AVARRYILAVIERETLEIRR (Delete instrument): FybMSAU ARSI
AUNERECLHIBRLET .

TRBEIINDFE: ITRBOAVARIILAVDERE|Y L TONT-REE 5 &
EELIETVIRTRIRTDEES. TNTND ARG ILAV D EEN DB O EE
[CEEHOLNTRRSNFT . MHRETIE. FENLAZOFHEN 1 D&, TH

ZDFEEN 1 DIFEDOONFET, HAWNE. TRTOERFE 1 DOEEPIZEEE

FBHIELTEFT, INE FSLEYNTIRELRONET N, = RSN/ —H
v avTIEIHFEYRLNGWEESETT,

MFTREBBTVIEIRE (Edit Percussion Kit) IF 47045 THREL=-FEHEHERIT 50,
B—DEHOMMERTE20EFEIRT HIZIL, [EEEEA T3> (Notation Options) |
DIFTEZR (Percussion) IR—VIZH AR LY EYMNIBITEIEIRD R
(Voicing for drum set kit presentation) IZHFEZ DA T aVIZEHELET .

Voicing for drum set kit presentation:

0 [6)
TT)LBIE wrRRsARs
- po o be \.1 ‘r“ o
et 2 1
Use voicing defined in kit editor Use single voice

512, M#TRB XYM EMRE (Edit Percussion Kit) 1% 470457 DIRSLwyk
(Drum set) 1Z#A4 U E T4 TICTHIETATEB/ I VNI LIZZDA T av%d LE
ETEET,

MFTR B X yrEHRE (Edit Percussion Kit) I# 4705 TlE, WIHREDHFED
AREAVRARG LAV EITHRETE, FAV R ILAV I EILERZ /AT
B0 FHLWESHEFERT AN LR ETEET  METYT TIURRIILAUIE 1
DEIRTBHE. THaAvN—LEDATLarMRETEDRIITHYET,

Stem direction and voice: = J H 0 =2

BRRAVEI)VILT. HROAMEEELEY . AV AL AV EBEADES
[CHBSELIERE. BRORFEZEELEY . HF . TNETNOFEDARIC
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BIFAEEHOHICHIEL TS0, BMICHEN LRAESETREOEEIZH TS
EIToHNE BFEEETILEIHYFEEA,

BLERICE T OBMEELSTAL— 3 TRETHILETEEFA. RILEH
DHTELGLTaAL—2aVDEBERIEAELES- LGS MERE TIX21Z2EH
LTRESNAZLITHYVET . ADYIZ, TaLb—2avhRVADEFEVIVIET
HILTEMNDOBBNEDARRIE. 212 FALLEVKLSIZT H5E (L. MRREEA
723> (Notation Options)IDIITHER (Percussion)IR—IZH B FvbhES:-
(XTUYRDEICRARANTERYES/—FD TR (Overlapping notes in the
same voice in a kit or grid presentation) 1Z—&&EW\TFaL—avIZHIZ TY
Y#ETH (Truncate to shortest duration.)IIZERELE T,

AVRRYILAVEDFE 1 DHAEFDALEFHITRIHEETEL OIVREYIL
AbDEEEEHRELAHONIE. RILESMERXETEET, 2FY, EFOBENELC
THAHIN . EFDIELODBERFLABMEN —BTIHEBEEERATHEE. EHEIC
EfELAHNIE EFDIELHDBERLTAL—avEE >BE/RELTRESN
FI, EEICEBREALZIMEE L. BEIMNIZES 1 DOFEHIMERSINET, EFF
PZOMDY X LIZERHEOZVEE AR, ERYDEEILZOFEIBICEESN
FY,

Tl AR AVRD 1 DFERRFDBOADEFICHL. PAREICLEFEE
DERE LEEZTEHELETEFT, CNICEFEHELEESTLEFREERLT.TH
£ (Edit)] » T#TESR (Percussion)] » [EE%ZE®E (Change Voice) DY T A
Za—ho FENLAEOEBELEFENATREOENEERLFET, LEEL
-EHFEMTRBIIYNERE (Edit Percussion Kit)I# /4704 THREL-#HAR
EDEICETIZIE. TEFOHDERARD) Y (Reset Note Destination
Voice)1##IRLFT .

ERRCE ERREAE. BETFONRERE (Playing Techniques) /3R JLE
fzI [Shift]+[P] DRYTH—/A—MSEBMTEET . NA/\VbDF—T/oO—
ADANGENTEFTH, CNITMA TEEEITERDAIVRARYILAVITIE B
BAMEOER. SN BERRLEINIBRLDICLFELEISCTADEE. 7—
TA¥aL—23y (RAVA—h. 7ORINGE) PEEOMNEO (B—/ILDT=HTE
E) MEMIZKY, SEIFGERBEZIRETEET,

B EBICERINTVSEEREZDEIYNERET HI12IE. ITRBOESRHE
(Percussion instrument Playing Techniques)1¥ A 75 #EALET . 547
AJIELUTOFIETHEET,
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o TL—V—ICEYLTONEBERDAV R AV DBE, FEE—FTIL
—X =R RIADTL—Y—Dh—FZREAL. KEDAURLYJLAVRSN)L
D> 1% 9P T AVTFRMZa—SITRBOBREBEFRE (Edit
Percussion Playing Techniques)lZ:&RLET,

o AVRRYIAVIHHTER T YMIEFNATOSGEEF. FTHTERF VMR
£ (Edit Percussion Kit)I¥ 1 7RV ZMAE AMUIRETIT M OERHEST
RETDAVRARIILAVRERIRL TS, 7O av N —D T ONTRBOR
BPEF&E (Edit Percussion Playing Techniques)1&2')v L% Y,

L] Pescussion instrument Playing Technigues

gl tepaes bt (unsat]

W baH popgan Below - Bl

Playback of Articulations and Tremolos

Arthculations: = | A - — 1 i LR
Teermeis sroker T o o
o | w | s -

S ] -

4707 OLEBIZIE BIRPOITEFICERSIN-THERBCEN R TEIN., FF
BOEYMO, FToav LT COBERBEICH G T DERNODMENR TSN
FY ITEROBRBEEEE. DKLl FFaTI)L (Natural) INEERESNFET,
ZLDGEENENYREDFEEZFERALTRRINET,

FLLERBCEZ BT BIZE, 7O avn—DIM+1RE0 %99 H LT, RRSh
AT aT e T HEERRETERLET . TOKIZV YT HE. F4T70YT
DLEEOVAMFLWEENRTEINET , COESREEICHHPREDFFELYE
ZERATH5E . [HERTE (Notehead set) JIZ(FEENDHELEREETT(RE
5E) (Unset) IDFEFICTBL. IFEAF T3> (Engraving Options) IO EFF
(Notes) IN—U TEZEL-MHREDHELYMERSNET, COERKZEE
GUIRSAVDLEEFIETDAR—ZAARET SIZIE, IFERNMSDEE (Staff
position)1Zl £ (Above) FE=IEIF (Below)IIZFRELET,
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TEBOEADANDFITHEEPRISEREIEZVIYEZ DI, [Shift]+Alt]
LGNS RENF—DLETEHLET, IoIT, ITEBRODESREE (Percussion
instrument Playing Techniques) IO 7—F4¥FaL—3 0 EFLEODEE
(Playback of Articulations and Tremolos) 93> Tl&, 7—T4Fal—i3
VEERBDINEODHEDHAEHEICLIERNGERREEERLT. (47
AY EEBOVRAMCEELZEEBERREICEBMTEET,

FEZIE. A—LERRTDICIE. FTHFATOTDETADT I3 N—Tl+1%
DUYILT VRMIFRIEBZEBMLET . BEEEORTEOBEICH LI ...1R2
ED)IILEREBEDANMSIRoINERATS, TOKIZS) v L TRINE T
ELET . [Crl] #HLAEASHY Y (Windows) Ff=IE [Command] ZHELAMND
2Uv9 (Mac) LT, COFATET oD BERREERIRT HLELTEFET,
EERZE. FELERINLDOMBEDHAAHELLTHHRE THRESATLS

BRBUEEANBATHEATHIGSIIMESTM®R (Replace) 1z BEREZEMNT
515&1EMHEM (Add)IZEIRLET , COTRoll JOFITIE, TEEHZ (Replace)]

ZRIRLET . REIC. ROIIDFEEH T =HDRLEORNO—- D EIFFEIRL
F9,

CNLEDRERFT AT, TACIIMNADITREBZD AV AL AV MIREFESNET
BRELZEZTHLT, HEAotDTOPIIMIRAHRAATHERTSHIELTEET,

T—T4FaL—2avBLUOMNEOICH T S LEEZ L, BRRATIIBEICRBSA
FEAD, FFEMITEEEINDSFETT,

ERBEONEO LEE: TITRBORERGE (Percussion instrument
Playing Techniques)1# 4705 TITH>T=E L. ITEBRN 3 DORTREIAT
DVWTIEFERTIESICLERASNETN AVAMYILAVNE 5 REEITRRT
BHERIZ 1 DU EDMMDAV AR AVREEER EDMEZHEBFTHIHEL. thD A
VARG AVREDERENGNKSIZT S0 FRTINEEERTIDLENE
CATENHYET, HEEXER T HICIL. NITEFTVINEHRE (Edit Percussion
Kit) IF AT AT DA ARET )T REE EEET DAV RMYILAUMEERL .,
[FFEEZ#RE (Edit Noteheads)1Z#2)vILET U TDF (7RI HARRINE
ED
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L3 D Overrice Porcussion Notebeads

Slashed Noteheads (Top Le®t to Dotom Righ  (Unset

Crons stk Large Circled Noteheads Unset

CCIZIFMTRBOEERE (Percussion instrument Playing Techniques) 14
AT AT TAU R ILAVKIE R TN ISEREEN)RNRTSN, ThETh
DEEICIIE T SN TWSFHENRIRINET , MEBELXZ LEESTTHICE, ZET
LEEHEDIFED LEE (Notehead Override) IS LEY)YHL T, KRS
NI A= —DEFHLWFEEDEEEERLET, TOKIZI)YIL TGEREHEEL
F9,

HERTIVNDEZTHLEGAAH: TITEBITYMEHRE (Edit Percussion Kit)

BATATEIVABET HF 470 T HEDITERFTIYNMIRILTITHST=TRT
DEREFX. SATF)—T7AIIESHLTHOTOD I CEARATEES, 54

To)—DEFHLICTIE. THTEFTVNEHRE (Edit Percussion Kit)IDETAD

FEyhZEEZHL (Export Kit) 122y IL RETDI7MIILDARIEIGFHEER

LET,

EFHLITERIYNEMOTOD I ONTHERTBICTIE, AV ARS LAV NMERKR
YT —N—DI XY EFHRAIAH (Import Kit) IIREED1)vILTHFYLEIRDT=
SAT3)—=T7AIWNEERT D REE—FDIFL—¥— (Players) /AL TT
L—Y—%H2)yILT. AVTHFRAMNAZ 12— FYrEHARAHA (Import Kit)]
ZERLET CE0DBREETESTH RARALEZFYNMNEIERDOTL—V—IC
BYLTOENET,

HEBRDBERANDRE: BERBITEROAVRAMIIAVCOEE LSRR
DEEIIANFENDVLELGYET BERITEROANICK BEOAANFZE
DNERTFEATEETH.MIDI F—R—FFE[FIVE1—2—DF—R—F%FEH
TEHEMERIZANTEETS,

MRIERTE (Preferences ) IDI 2} (General) IR—IIZIE ITEBOEHFAAIC
B3 54T avm 2 EybHY.1 DIE 5 BHEADAN. S 1 DT UVEEE
U 1 BREADANICETE4Tar T, LTOERRKIE. MIDI F—HR—FH

Dorico /\— gV ERE 29 R— Steinberg Media Technologies GmbH



Dorico /N\—L 3V B

G steinberg

FVAVE1—E—DF—R—F, ELLIZEDANICLHEEESZAFT,

Input onto kit: Use percussion map

Input techniques from MIDI key: | 48 Uu

o N—HhyiareyTEFER (Use percussion map): /A—hyiarwyTid,
YOURSATI)—DEED/NYFIZIROONT=H DO REED MIDI /—+T
BoTMEERLIZEDTT, ;=EX (X, General MIDI DITEIRTIE, C2 (/—
b 36) A/SRRTL. D2 (/—F 38) MRARFRILEVNSESIZEZEINTLVE
T, IVEV T DFEVAZH>TLSEEIE. IvEL T EFERALTEEANTS
LEFTLED,

o R FDAIEZEMA (Use staff position): COATLavERIRTHE THT
B X VMERE (Edit Percussion Kit) I 4 70Y TEZSN LR EDAL
BEFERALET, =EAIERSLEYRTIE, NARSAZEERERDE 1 I,
ARTRESLIEE 3 MICEESNES ., COERLOMEL. FERETHN
FEhEh F4 & CEANBESTHNIE A2 & E3 ITHT-Y. FERTLHEH
[CEOTHIETEIENEDYET, TN, 5 RE~ADANTIERLDLE
#fEA (Use staff position) INBIRSNTLVSIHE . ER LOAENMER
BEABRBLELLICLDEDHIDIBETHIENTEET,

Mk FOGIEEER (Use staff position) JIZERESNTLVAIHA . MIDI F—R
—FOREED 1 AU3—TO&EHEE . BEEREDANIIEETEET . IHERET
(. EZEHZEEAHNT S MIDI F£— (Input techniques from MIDI key) 14+ 7%
av(& MIDI /—k 48 & (C3). DFY HFR C(C4=MIDI /—h 60 H) O 1
+H8—TFD C ITHESHTIVET . MIDI Learn [W Ra2E5vsLT,
MIDI F—R—KRT/—hERTE AV JEHEERIRTIEVFEERTEET,

FtRE Y F A C3 THHELT.C3 Ao 1 AVF—TLFETO/—MILTD LS
[CEIELET

e C3(48): 1 DHIMERRIKICUIYEZ

e C#3(49): RODERBULEICUIVEZ
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e D3(50):1 BOHITIYE T SNIZEREE
e Eb3(51): 2 BEHIZTUE T ENT-EBERE
e E3(52):3 BOICTYELTESh=BERE

o L RARIZHK...

e B3(59): 10 FEOIZwYELTIn=EERKE

BEEITEROANCEFERLOEEFER (Use staff position) IZEREYT
BIEEBTIHLET . [1—hyiareyvTEEM (Use percussion map) i
BHE . General MIDI D/A\—hviarIyT&#RBELTWSI—H - S LtEvrE
ARNTBIEEDHERTT,

TEBROEHDOAN: RIRFATIZ 5 REEFIT VYR EFERLTITERD L
EANTHER. FrLYMDORSFEETEEBOEEZANT HEESRYBERGY.,
ERODESEHRZLHDIDTHLGBFENERMVNEDHETT RSITHEVET, F=.
ETORMNF—ZFEATHEFVLYNE L TOERICEBBSEDHIENTEEFY,
BROL VLTV IEDTC LIZE BEMEDITESRZA VAL AVRE B
HEDERRE HEESNTVDER) ARRSNET,

BEREANT HAIC, BUGEEREENERIN TSI LR LT ZE, aY
Ea—2—0DF—"R—FTAATBIHEEIL, [Shift]+[Alt] ZFLENS ETOXE
F—ZW T L BAEDAVRRYILAVRDEREENIYEDHOYET , MIDI F—7R
—RFEFERALTLSI5A(E. RIERETEZLz MIDI EVYFEERATEET,

ANRITEREEZBIET H5E (L. BREZFIRLT [Shift]+[Alt] ZHLAA S
EFTFTOXRMNF—%0g L WEBRPDAURMYILAVCDBEEEENTIVE LY
F9 .5 BEFEIETUIRTIE. BLARICUIVEZKGITTREDA A RYLAV L
DEERREEIRTRRLEZADE. BN ZDOAMDRDAV ARG LAUE (5
RELDORDME. FIETIIRDRDZAY) ITBEILETS,

GVYRFERIZBER DA RS ILAERRTLUIIKETITREBFZ T INIA T BE
(X, /—F&TAINBIG], £f=1E MIDI /—k (EEBGEZTEARICEESN=494
—TLUS) OWWTNOEANTDHE, FYLICDBREMEDSAV LIZEFNAA
ShFET,

— 7. MRBEETE (Preferences ) | CIEER EDLIEZEFEA (Use staff position)]

EFERTELIIREET 5 BREEICANTBE EAIETFIZANTBEF ITRIGT B4R
FEIEBIZEBRNANSNFET, ERLOMEAMERSCEEMTON TN
B.F (X5 1 MFEEIESE 5 RITRELETAZEDOFSLEYHNIX, IhlE
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FIIRSL (B 1 M) FESARD 2N (8B 5 B)ICHI-YET . CDEE +
YLy DRAMEIZHEL, FTREGRY TE(E EDER EDOMENBRENET,
EEL FYLybORAMEISEVERVESYL, RRICADLEEFEFED
AEHMNRLEFDERMENMEEMISEREINETS,

REDRSLEYNTE YIRS LERRT RS LDEREANTHELELLS V0
FILIEXE 1 BICHYET . ARTRILIEE 3 . 2FYE 1 RoDFERA
EDREMREIE 5 ET.—A% 5 & (A2 NIL) hoDERVEDRERIL 4
EITBYET . FT . FILEIFOEROTRICFvLobEBELTHLOF—HR—F
DIFIFEEFRBEZHLT, FYIRSLEZANLES  RICF—HR—FDICIFE(F
BRBEHLT, ARTRILEZANLES, CCTHF—R—FOIFIFFREBEZEE
BYEERSE 5 MDAV UNILOBERTIERELLE 1 BOFYINSLDE
FAAANSNET,

NE, FYIRSLDBARTRSLERLFED AR (DFYRLHERR) EEALT
WBMBTY,

FEYIZHTENZXLT)IRD EIZRRENTNDA VAL AVRE LVES
BREICHIGLIz, DFYBRAEF VLY RTRENTVSER LONEDEREA S
TBRHIELTEFET,

T—T4Falb—lay: RERETVYRERIL 5 REICLTHEETZHE. o1
ARYILAVRERIMRIZ T —T4F 2L —2aVEBMTEET, =1L C2TEMT S
T—T4F2L—2avIE JUvRERIE 5 RELORLERHEZEEF TS, RILMAE
[ZHEITRTDAVARYILAVMIERESNSZEITEFRELTZE N F2EX EL R
FTRSLENLMLDBERNELLERILMEICHY . CNIZT I EEMLIZE
B VPR ECIEELLDERLFEN TREDEE TR IRIND O ERIZIE
BAHDADRACY VAT I EBIENET  RIRFATEBERI DA Xy
IWAVKNZEIYE R DL EBELD AV AR ILAVMIEZT VUM RIREINTNSD
BRMYET,

ER RREJTVIRERIE 5 REICLTHEET 58, EFEANTIE BLE
BICEBTHT R TDAURIYILAVMNGERFIEMEINET  BERCESIZET
% 2 DDAVRMYIIAVMIELD VAR X LERRHET HIHE. BAHDAU by
AVMDRTRIATITUYBEZDE. TNENDA VALY LAV ZERIDY) X Lz A
HWTEFET BE.JVIFEREE 5 REDORRICTEHE, TELEFTIXLDFRE
ZRET A1, BEIMICERAEINET,

* BEWHEYIEANHOLBE.BATESITL—LavADEFDIH—
ANGESh, Ho-BEHELTEMSNET,
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o AVRRILAVEO—HIZFEHABY. L3~ EEF TREVEFI DD
BE . EFTHEVEFFERLRALBBMEICHY . EFOL ROBEITIX
FHTaL—LarTHIE. BRTREVEREEFO—HTHENDESIS
RRENET  ZOEHHEHEFALHBEE THELOTHIIL, KD
BEFIUR EREDLANHTY,

o —HADAVAMYILAUEDEFTIELEOVEFNEFOFIIRMELRICAE T
FEORWMEE . FELIEEFRDRP TSHITMOEFINRBT SR, HE
BT AL—avADEFTREVERASESN, Hol-BFEEHELTERMNS
nEy,

TUYREIE 5 REDRTTEHFZHIRLI-GEE. RALERMEEXETHIIATD
AVRRGI AV DEFDNOEFNAIBRESNHZEITEREL TS,

DAV RARYIIANETEFEMIET: 5 REFLETIVRORTIATE=FEAL
TWSEEE. THRE (Edit)] » MERFTHIZT (Cross Staff) IOYTA=21—%
FALTHDAV AR ILAVMETEREMBIE T ZEETERE A 2L @RID A
VARG ILAVRDRTEAATEERLTODIHE DL, FUMNIMEHFRAETNTLVELVE
BDAVARY AN TL—Y—IZEHEY B TONTWSIEE L, ITESRHEZE
EWCEFEZRIETIENTEET,

EEREGK 90—XRENA1\YrDT+] F—=Tonan\vtDlol i EDEEREIL.
DA Ry IL AV RERRE, [Shift]+[P]ZH T ERTEINZRY TH—N—, 1=
(FECFEE—FDLEZRE (Playing Techniques) I/ A\ RILEFERLTEMTEEY,
BEEREEEBRLTOWSERDLET DIV ARYIILAVMIDAEBMENET

MEEL S MBS IO TATLEEELY ., JUVRE LY 5 BREDORTI(T
EARNDAVRARYILAVRDRTEAATEDETIIEBESNF LA BROAV AL
HILAVMZEBMUTBREERE S E TR T Y UyRERIE 5 REDORTIATIZUVE
ABDERTINIGLGYVET > T. JUVFE LY 5 REDRTIATLER DA
DRRGIVAVRDRRIAATTEN T NGB IRTEBELE BT ZEBMTEES,

TREBORTYF2Y: Dorico 121, ITEBDRATAYF T ERTT DHEENE
FEREINTOETAN HhOVYICHREAKEEZERT A ETITERDRATvFY
JERTTEET, MEALEBMTBIZE. RRFAATNTUYRERIL 5 REDIFE.
RTAVF T EBRT DAV ARYIW AV DBEREERT 50, HAHWXER DA
VARYILAVRDRTRICOYEZ, TDAU RS ILAVNZEEIE FTERBORT
19F¥ ) EAALET AR DAV RARSILAVIRTENORTRIATERTE. Y
JyRE:IE 5 BEICTANKRINET,

RN HEBOERINIIE, RRFITITES>TELGYFET,
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e 5 fREE (5-line staff): MFTEIJ/XVMEIRE (Edit Percussion Kit) 1547045
TEREINEXBMELIIBIZERTHERINUN 1 DRTENFE
ED

e JUyK (Grid): JVIYRDEFAVIZEERINILDAZENENNSKERTINET,
FINNVIZIEERBIHRE (TN RREINET  ELHETITERTVMERSR
(Edit Percussion Kit) #4704 Tl &HiZ#wE (Edit Names)1&9')vo3
BHERETEET  JUIYRTHET DAV RN AUNET L—TILTEET,
CDEE.TIL—TDIRIVIETIN—TEEOMABMD P REEICRTINE
T T IL—TDIR)LIE, TFTEI/EVLERE (Edit Percussion Kit) %47
AT DA ARET) 7 THRETEET .

o 1 REEMATEIVAMYILAVE (Single-line instrument): &A 2 XksIL
AUNZIF, EXEMHIVEEHONThADSE, RRMABISEYLERS
RPN A X TRERSNET,

F)IRRRTIE, BIAVDFENRRINERINIVIITERSNIL FTESRT
) (Staff labels (percussion grid)) ID /855 S5TR A VEFERLET , SRE(F.
[%2 (Engrave)l » TEXE XA A )L (Paragraph Styles) | CiR&ETEZT,

ITRBOLOIUR: RRZATE 5 REICTBE ERIZENDAVARYILAVE
I RTRRLIEY, BEINBZAAMYILAVREERMICRRLIZYTES=0OE
MEHEELHYET,

5 REEICEREINZITRTDAVARIIILAVNERTTHLOTUREERT HIZIE,
LTV RERRSEDIERLDMEICHIBFOLZTDOMDT AT LEERL. [
& (Edit)] » T4TESF (Percussion)] » T[T RTOAUARYILAVRDL O VR
(Legend for All Instruments)1Z&ERLET, chIZkY ., LIV RAERLEIZ—
BERTINFTT, XRRIEIL., BERUBDO EMSTICEY Y TONIEEELLYET,

HEDMBTEREIN TSIV RAMNIILAVRDARTT DL REERT SIC
(T, ERMNASERE 1 DRIRTHHEEZREIRL. [#EE (Edit)] » TITEHF
(Percussion)] » NERENTLBASVARYILAVEDL Y TR (Legend for
Sounding Instruments) JZ:&RLET LTV RNERD LICKR TSN, SFE D
BEIZHWNAURILDRREINET . CONVRILEIIRTRSVT T 5.
[Shift]+[Alt] ZIRLAEALERDKRNF—ZHL LI IVROTaAL—230FE
LS BHIET LVIVFDRRICEENDA VAR AV NDERZIE R TEE
ED

TANTARRIVIZEHLGEMESN-TITEREDL O UF (Percussion Legends)]
TI—TTIEATEROL I FDOMBEEEROTICEELRY., TIRIFEMER
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(Use short names) IZBMICLTA U R MY ILAV D BB ZFERALIZYTEET,

HBBOLOIVRDITAU A X PRI ILIE, [%ZE(Engrave)] » TEERZA
JU (Paragraph Styles) |IZ&A$T# 3 DL TR (Percussion legend) I THRE T
FFET,

ZDMETEREINDIVARY LAV GEWNGE FETVYRMERI DA X
GILAVRDRREA TGO TVNSHE  ITEBOL O UREAAMRELTRRSN
FY ., HAFDRTIFERTRIE. [Ea— (View)] » THAF (Signposts)] » T$T#
F|OL PR (Percussion Legends)I THUIYEZLNFET,

N—=HhviareyT. EFRITEBOAVARILAVNE, BEEROYOUREER
% MIDlI /—HIRYEVY LIEYFEFERALTEESINE T, f=&X(E. General
MIDI DITHEIETIE, /SARSLAIE C2 (MIDI /—FEE 36. R C D 2 A4
—7 ). FYIESLIE D2 (MIDI /—hES 38), VA—XF/\Af/7\vwhE F2
(MIDI /—+&ES 42) EWVSIESITIVELTEINET . COEYFIX. T/IAA R, B
T5—54T3)— A= Hh—EICF - TERLGIBEDEFTREDYIVREXET LD
[CWHBEELIRYET A FTEBRD 5 RELFAITHIEEDERLOMELITERR
T,

Dorico Tl&, ITEBAVARSIILAVEDEFOERREDRELORBELBAS

NBEYOURERVOFTBE=HIZ, N—hyiareyTE&ERLES . /A —hyiay
TYTIZIE. HEIBFED/XVFICEDEEBITERAVRMYILAVNE DESRHE
NIRHLEN TSN, TDBERE (FEAILBEICERYTS MIDI /—Ro 4
TLaveL T . BEDBEREEEN H—3 50D F—R(yFELTHERT S1th

D MIDI /—kgE) BEEEHSINTHET,

Dorico [ZI&. HALion Symphonic Orchestra #d4& U HALion Sonic SE ) TGt
HHETAI 3 —D—ETHS. EFEITESR/ N \VFRO/NA—hyaryTh 1

TIREFENTEY. TADTIMIITER AV AR ILAVNEEBINY & B ERICE
RENFT,

2L, =R —Fu—BD YD URSAT3)—FT=IE MIDI TN/ REFEHTH
BEF. ELLWEBAHEREBD=0IC 1 DUEDHARZLIN—HYarIvTEE
EIAIDELHYET, ILOHIZ. TBE (Play)l » I—hyiarevT
(Percussion Maps)1Z#ERLET .
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D Percuswcn Vags
Garersl MO0
RSO Cowbelt Percussion Map -
MO Cyrbal Lanoge Coenbi KS
WSO Finger cymbals Name  Goversl S04 Wi Gefnes sounds for i
M5O Genn Coansa Comis &5 O Gumstapgm _ Sngie ntrements

M0 Matt] A Dus Comtd ey
4GO Segh b

HSO Snare Conbi K3

MO Soare Combs Key
NSO Tam Tam

NSO Tamboories

PS5O Temple Block Combi Key
NSO Triangle Combd Key
PO Woodblock Carrbs ke
FGSL Latin Porounsion
PESE Table

PSSE Vrnlap

Drum Kit Note Map

M Noe Wb NaTe et Ently Name Aey SWAN Pliyng Technigues

[ et Lneary ety | ot Lbeaey.. || Erpot Loy |

ERIDOVAMIE BEQTODIIMIBRARAENTNDTRTOD/A—hyarT
YITDRRREINET, YvTE 1 DEERTLHE. ARIDAMTYTDFATRTIC
FOABMNERTENET, 722avNnN—0DM+1529)voThHE . ZEEADTYTHE
BenEd . [ERIZV)vIThE. BRLE-TYTOIE—IERSNET,

HRIDT/IR—HySar<yT (Percussion Map) |9 ar Tld, TTVRRA MR
5 (Endpoint Setup)1# 47045 (ZZTIX, VST 41V ARYILAVREFIE MIDI
DHEATNAZADEDF o RIVZEDIN—HviarIv T FEHAT M EIEEL
F9) [CRREINDN—HYParIVvTDORFREEFIEELET . ID T4—ILRIZIEE
BEOXFINERETEET, [YVTITERZINSER (Map defines sounds for)]
AToaviE. UTOS6EUHAICHRELET .

o  TILFAUARYILAVE (Multiple instruments): YT EERT B/ VyFH,
=&z (X General MIDI MRS LIYTDESIZ, SHDELDITERBAVRLY
WAV ENSHEITERLET .

o MBMDAUAPYILAVE (Individual instrument): ¥y TEERT B/ \FH,
ITERR 1 DT TRRENSEEITEIRLET, f-&A(E Virtual Drumline
DARTRILZAVDINYFROZDOMEMMLEY L T53—54T3)—D K31,
1 DDAVARYILAUNERDBEREENRESNDGEELHYET

[FSLFYrD/—bTyF (Drum Kit Note Map)ITU7IZIE. 0 FAD 127 BF
TOFARTD MIDI /—hHRRRRSN, ENEND/—MIH L TEERREL
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BRBEADOHAEDLEEEETEET . HLWNEBZEMT H5E(E. £ MIDI
J—bDYARNT DT I3 N—TIFRTZEERT (Show all)jx#0)voL., IvEY
TJENTWEWN/— ERRLET, YVEV T EERT S MIDI /—RIZHRIELTAT
ZERLFET . A 4707 TOIRFSLXYRD/—FEHRE (Edit Drum Kit Note)]
523 TlE,. 2O MIDI /—HZIT—4%EETEET,

o ARl (Name): 1V RMYIILAVREBREBEDHEDHAEHEIZH T EHRT
ZTT VST A2VRRYILAVRS MIDI HATNAADA—H—ERBAETER
SNTWWBEMZEADLTEEVEEA,

o AVARFHILAVE (Instrument): T...1%41) v~ LT, Dorico TERTEST AR
TOEBREITER[AVANILAVLD) ALNERHEET, 2D MIDI /—FTH
B A OURICRET ABEUGA AR ILAVREEIRL T, TOK1ESY) vy
LET,

o EZRUE (Techniques): ..0%41)yH LT, Dorico THERTESTRTNDE
EREDYRNEREET . 2O MIDI /—FTHRETIHEED Y I URICHE
TEHEYEEREE (A EO—IL, YARRTav9, )L avbgE, [Ctrl]
F71E [Command]Z#HLAEALI)vI T HEBBUBRIRTEEY) ZF|IRL T,
TOKI1E2)vILET,

o F—XAYF (Keyswitches): COHIURIZEWNT, SOAVRMYILAVRE
BEBEOBEDHAEHLEEN)A—3 5825 1 DO MIDI /—h&
EETIBLELNHDEEE. COT—ILFIZF—XA(YFD MIDI /—+ES
ZHRELET,

[FSLFybD/—kyT (Drum Kit Note Map) 1D RMNDIVEL ST Sh TV
MIDI /—FZE&RL T, FNEFNTRSLX YD/ —ERHRE (Edit Drum Kit
Note) IDT4—ILRICEEAT EEE . WBLEIVEL T EIT R TERLIEAZADET
TET TOKIZ V)V ILTHAT7AT DRABRERELTHSTOADIIMNERET
BEMEEDEDHRTLHHRENBTEREFTEET,

N—=HhviareyTEERLIzL ., REDRTYTELT Dorico T/\yFE/N—Hy
LAV T ORIGERELET  RELITHIICIE BEE—FT VST 1URkY
LAUREREIE MIDE 3020 B RavzsyvsLES TTVRRIVMRE
(Endpoint Setup)1F 47 BI DD T, /13—Avav /I \wFhHEHAEN-Fv
DRILDINIR—hyayF (Percussion map) a5 Lms, @i/ S —hyia
RV TEBRIRLET,
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L] 2 HALRon Soric SE
Mamber of M0 Channets: | 1 B [s=
Channel Expredssion map Percusdson map
w l.'u.-.nlu'bt R

i =23 1]

| S —

=)

BAE—F: BEE TR EETBITESOAVRALYILAVEDRESHEETRERE
BEFELGY, BEOET/O—IILRRTRE UTORIICHITRFZDEF DR
IR EARTSNET

FIMIASTZAV ARG ILAVMIZENENERD RSV INY T —TREAKRRTE.

BEDAVAMIILAEMDBEIUR RSN (F2EXIXRELC VST 412X Ry)L
AR MIDI EAT AL RDFNFroRIL0 BEIZHRLTERRIZELGST/NAR
BE) [CEVETAIENTEE T COEEERLIZIURRAUMIIEE T R/ —
Hvar Ty THBIRSNTVILELHHEITEREL TSN FEIRSN TV
WMEE. TDAVARY LAV D EE(FEETEE T A,

BEE—FTIH. BFEFSYI LTREDREIZBETEZ TN, BITOD/NN—23Y
DBEEE—FRTIX., BLAITEBBORSY I BHOTAL—avDERIITEE
A, COBEEX., FEMICEREINDFTETT,

FAAENT MIDI T7AILRNDITESR: MIDI T7A1IVEHEARALEE, TMIDI A
UiR—hA T3> (MIDI Import Options) 1% 47045 TM10 Fv> R JLIE General
MIDI /N—Awi 32 ELTERAIAHA (Interpret channel 10 as General MIDI

percussion) |7 T3V MNERESNTNDIEE. 10 FroRILEFERATHEIRES
NI,V IIERS Lty EfEIRENF T, Dorico Tl&. LEDERENINTINSE
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BDH . MIDI T74ILHDEFEMNITEI[EBIRSINET,

FARAFENTZ MusicXML 74 I)LADITESR: MusicXML TlE, EEEITERD
BEODRBEFENERHY. 7TIVr—a0 A BLGBIEE . ESHINET 2D
NEPIVI—FAEIIHTINELEZINENELGL-0. BRICIEEGTENERN
BEENHYET,

Dorico LIS DEEVERT TV r—a 4412 MusicXML Tld, RS Ly E
DEFEITERIERLICTEDHIBTFELTERE SN, EOIVRRYILAVE
MEDERMBEIZHIETENEANT D=0, EROE TIEHREEMLTLET,

Dorico TIE#IZ, FYMEHERET DMV RMIIILAVMEFNFNBEREICHEILTHS.
FHIIZ 5 fREEICHAAATET L BAIZESTIE. MusicXML D OPEBBRARIRE

Dorico D KYBAMAERBEDE TIYVEL T ETHESZEITH#ILL. BWMERE/BR ST
OICFRITEHERI D ERISEELHYET,

BE. Sibelius & Finale MBEEFHINTz MusicXML Z71ILDFRDORS Ltyk
DAVARYILAVME, ETEENVDITHEARL ZENTEFET RS LEYNTHEA
TEHEEC—EMUNHIEE . ETCERAL—XRICHEHFALZENTEET AL,
ARTRSLDOFENI AT TRAEDFEETRIESNTLVSIESE. Dorico ~DFHH
AAEEEICHETT, FERANMICEICEILTEHLIGEE. ERFO—EHRER
HINdh . BIRESEEHRARBENLGNIEABHYET,

5 fREEICEESN DM OIBEDITEIRIE. KYBHLGIERELYET, Finale (X5
REDBLBIZEDITEBAVARIILAVIRTIE LT EIN TSN EVNSIERE
EHESETHIEBAMAHYZET A, Sibelius (FFSTIEHYFERA, TR,
Dorico THEIMISEIRSNIzA VAR LAV BED AU ALY ILAVNERTE D15
BLHYFETH, HTEBFYIERE (Edit Percussion Kit) I (7R %#ERT
NIE. BEHEICELW VAR LAV NIEIETEET,

AR RB D@L Dorico &, BHEERT TV r—2a2ELTHIH T, Keda
Music Ltd. DEFELIZAVF AR OFHHLBEELE S R TLEYR—TOET 1V
FARERDHBRILEEEIFZTIDOITERISINELLA FHI F—IL F—5
D L)OFIR L ISWIORE MOAORFOmMBEAFICEHBERTEET,

o]

Tabla Y

S
Cal Ea)

AVRKREDH B EDFEMIZ DL TIL, www.keda.co.uk #SBBLTLFEELY,
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T—T4Falb—ay

[%E&AJa> (Engraving Options)IDI 7P—F4Fal—ay
(Articulations) JR—U DIKESRIE (Horizontal position) 1o avIzH b #F
BRIORZyh—rDKERE (Horizontal position of staccato on stem side) ]
AT avIC [FBEORLEFREDOPELIE (Half-center) 0D:EREEAEMSES
NEL THFBEOFILDEFREDHBEAIE (Half-center)1Z:ERT 5L, R3vh
—rDT7—Ta4F2L—2aV EFEOHRLEFEODLOPBMAEICREEINET,
D7 —T4F¥21L—LaVERBIFEET HERIE. TR TOT7—T1FaLl—23
UHNEEDMEICERESNET,

INETHR

[%E&4 7 a> (Engraving Options) DI ME#R (Barlines) | R—IZTNE#&
NEHTIREOR/MEZXFEATHERDBOZKE (Maximum number of
staff lines to use minimum barline protrusion) 147 a3 A F=ISEMINE
Lizo JUYR TRRSNDITEREYLDSE ERBOHAIZDIEELYE DA
e DRI MRS RE T HREOR/ME (Minimum barline
protrusion)] (Ril/\—2a>TlEMNL REEICHITH/MEROBSOR/IME
(Minimum barline height for single-line staves)]) D{EIZHit>T, —&F5MEID
ERENLEHLET,

NGBS

EROTOPMHES: EROTI/NEHREPRRA CERESNS/PMIESE. T
FILFTRBESORAICERESNSXIITHYFELT,

BYODINEES: TLLFIr4TFL 3> (Layout Options) IDT/MEES (Bar
Numbers)IR—2IZ 1 INIZ EIC/MTBESERTT HEE . XAO/MET D/
FEXIERT (Hide first bar number when shown every bar) 147> avh\$n
fzIZBMENE LIz, AUIZT & IMNIESEERTR (Show bar numbers)1%&l1
IMNIIZE (Every bar)JIZERELTLSIGE . XD /MEIBESHNRTEINFER A,

=
=

E—4)La—KRi5: Dorico |&, F¥—FE—FK (UTAFU . RUT AF=F %
E) e R—ILb—2RT— )L, TAEZwiaFEFA V2 =v IR —)L (&7 - #
FBLEEE - 2EOWMN—T3Y) BEDE—FRERHITO—FREEEYR—IT D&
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SUTGYELIz, E—FIINA—REFTZANTEEEF. LTEANLET,
e AZF=7F :ionian

e K7Y:dorian

e JUYTFY:phrygian

e JT472:lydian

e =YY T4F7>:mixolydian

e IAFYTF:aeolian

e 0O7YY7:locrian

o AOT 4y AF—: melodic minor

e N\—EZYYIIAF—:harmonic minor
e /R—JLb—>:whole tone

o FHUBN=WOFERIFITAIZYADFEE - £F: diminished half whole,
diminished semitone tone, octatonic half whole ZE7=[& octatonic
semitone tone

o FHUBr=wHOFERIFIT4SIZYADEE - 5 diminished whole half.
diminished tone semitone, octatonic whole half ZE7=[& octatonic tone
semitone

choDIA—FEES(E MIDI F—HR—FZFERALT, L TOIL—FFZELTRTO
AT— VR BB ETHANTEET , Dorico NEDAAEFE—F /ILO—KE
SLBRT LN ZEDOI—FRBICHE., BRE. FILIL—2a G ENHHET 51
DERRT DM DNTIE TEFA DA T3> (Note Input Options) IO TMIDI
AF (MIDI Input) IR—S DA T3V THRETEET,

[#%E+7F> 3> (Engraving Options)1DIa—KEEH (Chord Symbols)X—
(Z[E—4JLa—FES (Modal Chord Symbols)l1to arh#FHf-ITBMmMEhEL
tzo CCTIERE—FEORT—ILEE . TNTNDBEXFEAXFTRRT HHNIX
FTRTTINERRTEET,

I—FEREDERAERZRET S FEETFCHELAODI—FEEEHRET HLE.
FETFTASIILDI—FEEDTI4/ILED S (Project Default Chord
Symbol Appearance) |5 47045 TA—REEEDTIAHILEDNEBEERET HEE.
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RUD—FOEADI—FESZEREELZY. Aa—RFOa—FESTAI> DO
—REBEA VI FOAAETHRELI-YTDIENTELLRIITHYELT -, oD
EFRARETHESF RETUTDELIZITLYRYS L JIREL D FIRR RSN,
RARETDOERNRINES . T, —BEDTLYRIZLREVEI)VIT S
L RLEBEEOI—FESOREIZRNET,

EWiZDa—KiES: I%EA4FS 3> (Engraving Options) |OIa—KRES
(Chord Symbols)IR—UIZTERIZ DIFBEDKFEA Tt YE (Horizontal offset
when left-aligned)14A 7> ar b FifzITBMEN . ERIZDI—RESITDLEA
ANDF TV EIRE TEDIIITHYFELS,

IL—RDHDIA—FEBEDHNE: IL—FDHTHEAIN-O—FESDHEIL.
[Shift]+[Q] DRy TH—/3—IZ, fz&Z (ETCbass1FE=IEIGonlylEA D TEET,
RENBEELTOREELEH-EHI—FREBDIGEE(E. RyTAH—nN—I2 fzLz2 L
[FpedlEANTEET, [IHEA T3> (Engraving Options) | OMa—FEE
(Chord Symbols)IR—S DI IL—bk (Root) 1oL av(CEHLLA T arhBnS
N RFEILOIL—rDHDI—FEREDEELGNEREERTEDLSITHYFEL -,

3 EIREDI—FDNEL: 3 BERZTDREZE. EALICEIDKIITRTTHLIE
RLTLSEE LYBVWEEZELI—FESITHLT. Tomit 31F=IEMo 31A°
ELLFERAEINSKIITHYFEL -, HFEYVERELILGVKIGRE (A F
FG5MA917%: &) [XEASN T TGMA9(omit 3)JER RSB KLSITHEYELT=,

BB

ln'H

5

ERTRDEFEESITHARNRREINBESIZHYFEL=, TEa— (View)] » THA
F (Signposts)] » TEEREESE (Clefs)1%&:ERT BL. RTRIFERTEVVEZON
ij—o

SRSSRCS

BEBICxT 2 XFRBEESDEE: FEA T3> (Engraving Options) | DI54
S (Dynamics)IR—U DI KFELLE (Horizontal Position) 1o av(tHh b

BERHICHTIXFERBILSOEIE (Alignment of text dynamics relative to
note) 1A TS avIc T —F AV Db REIBEEFED LERIIZEFI (Align optical
center with left-hand side of notehead) |47 ar i Fif=IZBMEhFEL -, =
DATa %R IRTHE, HEOPRBICEHLE TRELIGELYEXFHRTET
ERDLEICERESNET,
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RyTH—N—moREEXBRBILESEANT S BEXNRBRES (f-p B&) DA
NBRFITBREDRYYAXFERELZSEE. AALERYYAXFARBLSOR
THERICEBMICRRESNDEIITEYELL =,

ZIVTHhOIRES. FE DI T TR OLERBEMRSBIESOHEE: BARIC=T
UTORMEELKBRTAELIITHEYEL .

HEBE—F

TL—LOER: THXRNEIFTST7490DITL—LERIRLIIKET [Return]
ERTE TL—LEZTILY ISR ERLBEARONE T DFY. ERK
BIISLTT X R TA3—F = RIREE DT 57400 EERT 577/ )LEL
D3—hFHEET,

4IL53—

EvFTCEREI4INE—T 5 THRE (Edit)] » T24)L53— (Filter)] » TEYFT
E/ET1ILE— (Filter Notes by Pitch) #4704 A#FHf=IEBMSh ., HEDE
YF DB FEERFLITERERTEDSLSICHEYEL

[ ] Filter Notes by Pitch

mﬂ Sounding | pitches to filter:

G natural in any octave
F sharp in octave 4

Clear

Cles
vl B inoctave |4 H"

F v Sharp

(o] (o] [N

FOyTA O A —oBEFOEYFLERESEERLTHS BN (Add)]
2y HLT. [24)8—FBER,R (Pitches to filter) ') AMZEYFZEEBMLET,
TIHIRTIE, BIRLIEYFIEA V=T IZERECIAINE—SNFET A HED
TO—TDEFDHETAINEI—F BHEIE. [F92—THE (in octave) &4
[CL. REVARYIREFERLTAI2—TE S EE/ELET (C4= 2FL C) . EvF
EIAINA—FET4IA— R T D56 . [BRE (Written)IHREF
(Sounding) IMEEIRTEET , T4/ILA—%FETTBHIZIE. IBIR (Select)1F=IE
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[EIRMERR (Deselect)1&xV)vILET,

vl armh EvFOURMITOD ORI EITREFESIND 0. TV I—1EE DR
URULMNBRBIZITEAET . [T1)L82—F5F (Pitches to filter) JRAMSEER
DEYFEHIRT 521X, BEFEIRLTHBIRLE-EEZHIBR (Remove
Selected) &2y LET, £l VRN EARFBEL TIAIINA—1EEZEFHRIZEH
BRI BIZIX,. THYF (Clear)lZE0)vILET,

D —TEEIEITTVENDERFRIT AR TEI(ILE—T 5 THRE (EJit)] » [J1)L3—
(Filten) I T A= a—IZ, TR TOIv—TF I TSV EBIRF LB IRAERT S
HLOVATUR TOY—FDOEFRHFITRT (All Sharp Notes) 1 EMTSYFDBFRFTAR
T (All Flat Notes)IAViBINIENFELT=, FzEZ X, MIDI 7ML EHRAAATIHRS
EFERELIEE, TRTOBRBREENROETHNTLE 2 LSRIGEIC. B

[CTRTOY—TFIETFVMEBRL TR ITE ST ZENTEET,

PERADHRRT LA —: THR&E (Edit)] » TD4)LB— (Filter)] » TEREA (Lyrics)]
YT A a—MFITEBMESA . UATIZHEAN, WEADBREILEIREBRAIYZE
BITITRADEIITHYEL RO L TOHFAETZTNENERIZT1ILE—LT=Y.,
O—ZRERFALEERIZ T E—LTIY  FEADSA S EIZ@RIIZT )L E—L 1Y
TEDLIITHYELIz, CNLDREEMAEHLE T, EXFHEROLAICH SR
HADTIY 2 OBFADAHAEBIRT DLILIENTEET,

70—

JA—%FEZTHLOF (7B [T7HL)L (File)l » TEZHL (Export)l®D
FAudio]. 70— (Flows)J. TMIDIJ, TMusicXML1D &S A4 70O5 Tlx, EEHL
ETHNE—RESHLTLATIMNIEFEIRTEE T, ShoE TPz IR
BINDDOT. EHDOESTHLRFETLESILTRBIRANBEZRBETEDLLSITHY
FL71-.

JA—DEFEAAFH: D Dorico FTAC VM BOIA—EFHAAAT, HiAAEN
BTL—V—%.  BRAHRAAETACIIMDBRFEOTL—V—I23—UF 5T EERR
LIzB&. TL—V—DJ L—TLRESh  BHRAFENLZTL—Y—D I IL—T L,
REOTL—Y—DORIET ST IN—TIIX—IUShFET,

)R

FEE—FTYVIHURDMBLERIERETEDLIICHYELI, NUFILEER
B9 AICIE [Tab] ZHL.EIRLI=/N\VRILEBEIT ST [Alt] #LENSKEN
F—ZFALET (KE<BEITSHHEEIL. Windows TlE [Ctrl]. Mac Tl&

Dorico /\— gV ERE 44 R— Steinberg Media Technologies GmbH



@ steinberg

[Command] ZREIFICHLET), TOVREFERLTN\URILERSYT T5H5IEELTE
F9, £z, TANRTARARILDTTYyH UK (Glissando Lines)17 IL—7I(2, 1)
YU ROmIHEDAEICET 5T O/N\Ta B FzI2mbhYELz, TUvH U RDEE
ZRELIGE  THRE (Edit)] » TROSav#Utyk (Reset Position)1%3&iR
THETDMEICRYET,

MIDI 74 ILDFHEAAH

BARAAA T3 DEA705: MIDI T7AILEHRAALE, TMIDI € R—k 4
7ay (MIDI Import Options)1Z# A7 AT MERRENET . COFLLWFA7OY
TlE.MIDI 7741 DRAHRAAHZETHIFEIFELA TV EBIRTEET,

e General MIDI 274 JLELTEHAIAA (Interpret as General MIDI): #2(Z
F5E. Dorico [FERTHAURARYILAVNERET BHE. HERSVIITIEES
nN=705S L o nN—%&FRALET,

e 10 Fy2RIIE General MIDI 78—hyiar L THARAH (Interpret
channel 10 as General MIDI percussion): #>[Z9 %¢&, Dorico (& 10 F
YRR ESNIVIIET AT FSLEID AV ARYILAVREL TR
HIARFET,

. ERERAVDEBICIIRTUYRRAUMEMER (Use split point for grand
staff instruments): #>(29%&. T2® MIDI /—FEBTRFYvb (Split
at MIDI note number)J[CHEESN-EIVEWVERFIETITRTEFOHERICE
I, COBELVEBENVEFETRTEFORRICEESINET (MIDI /—+
#E 60= IFJL C=C4),

o /—kROLT4+—%RTF (Preserve note velocities): #I29%&. MIDI 7
FA1ILHDOERZDBRFOAAS T—IREEFSN., Dorico L THESINFET,
BEE—FCTHEADEFORNOSTA—IFRERTINGNHD, COF T3
VIETIHILTEATITESTWET , MIDI F7AIL o0 T4—FHAA
ATZE. RO T4—FHIBRL CREREE—F CTANLIABRESZA ML TE
£935581L. TBE (Play)l » TBE0D LEZEEHEE) Y (Reset
Playback Overrides)|ZfEALET,

o ERMBEZHRERE (Preserve note positions): #IZ3%E. MIDI 774 LA
DELZODBFOFRBMEER TREDA Ty EIFT RTHREFSN Dorico T
BAEIND=H. T MIDI ERZDYXIVIIT4—ILOHFINET,
NoDRBREL, [BE (Play)l » TBEOLEZH/HE) YL (Reset
Playback Overrides) 1= R L CHIBRTEE T,
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S MIDI I7AILIZBASAEESN TLSIEE L IEESN TSRS EFHRAA
LFIHYFELT=,

MIDI 74ILDBEEEHZ : Dorico DIAVBARXEFTTILTYXLHESSIZHE
{EL. MIDI Z7A4IL DA AAHZEITEEFDHABEEIMLELELT,

BAL47 0 @ MIDI I7A4I)L: 8347 0 @ MIDI I7AILEHEAADBLSITHEYEL
1=,

cowHB: A RAENT- MIDI T7AILDAVARYILAVMIKIET BNy
ST, TL—Y—IZ&HIMNFIToNEES(ZHYELT-,

MusicXML Z7A4ILDFEAAH

FFEEAAT: MusicXML 70 IS, TIAHILMTIEIEWFESA ThGmHATEND
£IIZHYFELT=,

MusicXML DY UK ID: FAAENT= MusicXML Z7AILAD/N—FZT I+
IWRDBEYDURNEEINTWDIGEE . ERT DAV ARYIILAVNDIEFEERTE
FTAEICENSRBEINDKSIZHYEL-,

AR ILAVIDER

AVRARYIWAVRDERINIVE RS EROFLBATFEL. FOBAERDE
ZRIBMEZRTIT D-ODINILERINTESLIITHRYELT -, COINILIF, #
EET—FT [AltY] ZHLEAORINF—ZFEHAT N, YORATRSVI LT EZR
BTEET, COMEBREIE. TO/NRTA/RILOT—f (Common) 17 IL—TI12H
BIA7tyb (Offset) 17O/ TADIXIETY IDIEIZRBEEINET,

Fl=. IRNIVBRIZRRTENDTIRAME, TORTA/RIVIZEFERSNI-TA Ry
JLAVERDZERE (Instrument Changes)IF IL—T® 2 DOFH=HTONT1%&F
FALTLEEETEFET,

o T%EETXAMEIERE (Hide prefix) 124 Iz 5E TLAPIrAToay
(Layout Options) IO FL—¥— (Players)IR—J(ZHEESNDEETFR
FVIERRICIEYET,

o THRELTFHAF (Custom text)ITlX, B IMERLE=TEFRARTIU XYL
ANBEBEETBMZONET  BRIEARZTHIBRT 512K ThRELTHFXE
(Custom text)I7A/NTA4ZZHDXFHIZEHRELFET . 2FY. 1 DU LEDZE
AXFEANLETS,
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AVARGIILAVRDEEINILDAE: AVARYILAVRDERIN)LIE, EROLE
DTHFANTZATLOANBIZT IHILLTERESNDLSIZHYELT -,

RUKH

RARZER RETFTRAFEERTEDSSIITHYELE, BB ET—FTIE.
By bN—F TN RFEDE RO BFINERIEIRTEFET  FEET—FTE
RIBETORTANRRILDOTRAEEF (Multi-bar Rests) 17 IL—F2EExsnt-
[3tyb/S\—DIE (H-bar width delta) ] 7A/\T4 T, vt/ \—DIEEHAETE
FT, ENIAFTRADEZEZF VN —DELENTSRDEEZ (T EYRN—DE
BYET, Tz, FiEksn I8 DA 748 vk (Bar count offset) | 7O/ \T4%
FETLHE NHOBFOMELRETEET,

TEO 1 /E: T5BAFSa> (Engraving Options) IOTRFF (Rests) | R—
T. M MR RTIGE D/ D ISR (Bar count for single bar rests) |47
AV HINIEZL (No bar count)JITERESNTLNSIHEE. ZHD 1 /MELERIK
FELTHRDONIZYRR—REEZ N YT HIENGELBYET,

188

ERFEEITE—0)yR/N\—T 585 %: Dorico (&, RE—RMICERINSIER
FEEFEEIIE—2VIRN=TREED 4 DOLVATLEYR—ILTWET ., Ch
X121 ODBFFIZ.TNTNDBEIZR>TELLHFEMNTEINET . £
FEEEERTBICIE. TBEA T ay (Engraving Options) IO EFRF (Notes)]
R—CDIFFEE (Noteheads) 129 avIth I FEICE I(ERFFEE (Shaped
noteheads based on scale degree) 1A 72 a> T FED AT LEERLET .

Shaped noteheads based on scale degree:

ne , e d
o AT + T 1 1 o AT 1 1
@ E= .. 1 I I 1 ™ — T I 1
D) LI o +
Wialker 4-shape Walker T-shape
ns Hs d
o e 1 B A A
b -4 1 1 I T - | -
) | ZOX O N — DY, S T ] 1 1 1
- E 4 1 1 1 1 I 1 1
< = - |

[RAF—F—DIL—FDEE (Root scale degree for minor keys)ITl&, <1+
— X —IZBVWTERFEORZEZITHERT AN DONT, /1 F—F—DJL—KIZ
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FRYT LN, FEEFTRADADy—F—DI—MERT N ERETEEFS . S
BRLL—BBIZERSNEGVXTLTHS Akin 7 BOBIRL AT LIZE LT
(F. RAI A F—RT7—ILTIEFITRAD A Y —F—DI)L—MMIFZERALFET .

FEOBRKOBRIZTZICEHINDOEBNT., FEDANCHRESEERERIZELL
FT EBEEDI=YUIZ,AKIn7 BOBIKIATLIZETHR5—IL0D 4 ElR
E.ZAROFENMERINTVSIGEEDH. T ANBEIZLSZEENHYET,
FEALAMZOERTE=ABIEEZAZE. FENTAETOEFTIE=AKIEE
FRIEET, CWoDEFNERORCAEICHIGEEIL. UoizYEHS>TRA
BEBBRLTLEVWET, COGEEIE. TREOEHICETHMEZERLT. 70
INTANRRILDT— (Common) T IL—TDIAS— (Color)17ONT1Z&FEAL
TEBRICLET,

R IATAARIZBENGEFOEIE, YOARAUZ—A T RERMEICIELTE
LWFFERDRRERTLET,

Figurenotes© #15—: Figurenotes [FEYFIZIELTERIZ—EDRZEZF(FEHIR
TL (Bl A= EBE.B= #.C= &) T.HHIXELXELLELTHEEMAIT
DHEBIZILERSNTWET, TR IR T Figurenotes h5—%FERT BIZ(E,
[%E&4 a2 (Engraving Options) DI ERF (Notes)IR—IIZHFkShi=
FFigurenotes© H5— (Figurenotes®© colors) 1A 7T avaRIRLET,

HHEICHIHFEDME: FELDEAHARTLEDOEADIHTIXRVFEE, =&
ZEEENSCETFEEZFETHILAELDRASY A THMESNASFELEICDNNT,
FEEICH T HFEDMENRESNFEL -,

BHDOAN

EFEEBMORYTAH—/—: TERE (Write)] » TFEBMORYTFH—/3— (Add
Intervals Popover)] a2 RM#FHzISEMESNELz, TI4HIEDF—HR—F 3
—bkAybkiE [Shift]+[l]] TF . CORYTA—/—I2&Y, [ E/FICERFZEEM
(Add Notes Above or Below)1# 4704 BLU T (Transpose) &4 704
DEZLDHEEE . F—R—FHLEEMATELLIITHYET,

CDRYTA—N—%FATBHICIE, BEREEMEIEBATIEHFEERLTHS
[Shift]+[I] Z#LET . BXITLUTDHEYTT,

o BREALSSE (LTFICBEHEEMLENES) (& ADTREDEIC Tt
EFET,

o TJSADKETEREZEET DL EROEMFLFIBALS LARICITEON,
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RAFTAOHKEZFERTHE EFOEMEFFBANTARICITEONET .
f=EAE T31F 3 ELEICEM, Mt-21F 2 ETFICBALLGYET,

o BIIBEEFTHEDLHVMEE. ANLEEOSEITERMEFBELALEICE
FEEME-EBRTIRTEENEHINET, DFY C AVv—IIBNT
(Z.D FFa1TILDEFEZIRLTHDIZIZAALT 3 ELFEMLESEES.
F 7FaZIL0BEFRINELNET, BEEOME(E. FEOHIC. UTEAHNT
HILTHRETEET,

Mpl. Tperl, Ff=1&lperf] = &£

M1, Tmajl, F¥f=(&Mmajor] = AP v—

'mJ, IminJ, ¥7=[&Mminor] = <4+ —

IDJ. Fdim]. Ff=lEMdiminished] = T43=v>a
Fal, Faugl, Ff=l&lfaugmented] = A—F a1 Ak
ldiatlZEf=(Xldiatonic] = A4 F7t=vH

O O O O o o

e EFRBESORICIK.M2nd], I5th s BEDOEEHLAANTETIN. BE
HYFEE A

o 1 ENIRBETHEHMOSELZEMNTRIZIE. BEEZHVITRYYET, =2 IE.
BIRL-BFIC 3 ELE 6 ELZEMTBICIE.M36JEANALET .3 ETF
& 3 ELEEEMTAIZIE. I3,-3]EANLET,

o ERHRIZITITMELNHAEE. MEO—FBLOBFFOL, FIF—FT
DEFOTICEFNEBMESNET . ERLEMBOIAATOEFOLFET
[CERFEEMTHIFEE. TM2,-m2to all IO L3IZ. AhDmxEIClallFE 1
lto all 1ZEMLETY

o BRLEAMBO—BLOBFOTIZERZEMTBIZIE, ;z&Z1ET-3 topi1®
FIINZAHALET (—BLOBHFD 3 ETICEMSNETD) ERLE-FFTD
—BTOEFDOLIZERFEEMT B(ZIE., ;=&Z [ETaug4 bottom JID KSIZA
HLFET —FTOEFOE 4 ELITEMINET),

Talb—>avniwsk: TR (Write)l » TFalb—ar%#&E (Edit Duration)]
YIAZ 1= FzITBMShELz, ChICKYBEEDITURT. RAEDIA LY

DURE, FEEFUNDOTATLDEZRIFIIATES YT LizEEITTalb—3
UDRFYTEINBIET ERLE-BERFOZOMDT7ATLORIZEETESHLIIC
FYFEL=,

COYTAZa—2F [FaLb—LavEfEIZT S (Double Duration)J&MFalb—
2avEH41F% (Halve Duration)1d 2 DOEBHH=ITEMS . ERLE:
BEROTIL—av e EEEENIILES,
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BT BERANPIZTAL—aVEEETHEFVLIMDERIOEROT 21L—
AVNEERESNFETN. EHORSOERICHVFVYLYMN BBMICERORT
MEICERT HRIIHYELE,

DALT)yR: YZXLTVYRDEROBRKRELT TR 16 7 EFE 32 2 ERF
AEMEhELT=,

FrLybxE ETIZHBENT S [Ctrl]] ZHLAEAL ERENZHT &, FrL vy HHER
D LEDERICEEIL. [Ctrl] ZLENASTRENZRT L HBEORTEROHE
RICBHLET ITEBIYLDTVYRTIE, [Ctrl]] ZHLEAS L TORNZRT
EAVRIYILAVIIRIE LT ENTWS—BLFF—BTOERMEIZHEH
LFET,

MIDI ANBDELRBTDRIE: YA T —F—I2BTHEFDORELHESNEL
1=o

EAE

RILDEFLEER: FIILEELETIEEGMEEZRTICIE. TO/RT/RIILDOTH)
U (Trills) 17 I —TI2#F SN -T R ILREFETR (Show stop line)17A/NF1%
AUIZLT ML DERICEIERGOEHKICEERERRLET, HFEL T3
> (Engraving Options) DT &EME (Ornaments) IXR—DIRYJL (Trills)1t5
AVITHHR SN A T avEERTHE. FIILDOELBORSLIEEFHIHTEE
ER

R—ILALTFT Ik

R—U%BET D BETFDOIR—Y (Pages)l/ARILTR—UZBENTHEE.
RRAG—R—CDEBER—VBESDNEEN hDEED LESL—RIBETD
FIITFYFELL,

R

RENWAREDENEF<—2: TRE (Edit)] » TRAJLEE (Pedal Lines) 14T »
Za—(T . RENVBEDENFIET—UF 5 2 DOFmLLVATURAEMEINEL
T=o

o RENBEDBEILODIVTAVDMEEMIFT BICIE. RTIIEED BT HEE
DEFEERLTIRS ILEESE] (Split Pedal Line) IZ:ERLET S

o 2 KULDARFIFEET—ILT 1 KORFIARICLDDVTA VDR EL
B9 512, I—UF HRFIBEERL TR LFEET—Y (Merge Pedal
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Lines)Z&IRLFY,

HAR: RELBOTONTADTLRITERRIEDLIFESINIIGE T AIRH
RNINFT . FAFORTEIEERRIE TEa— (View)] » THAF
(Signposts)] » TRA)LER (Pedal Lines)I TEIRTEET,

WRBE

SLEE—FOIEEBE (Playing Techniques)l/SRILADT AT LIZRI RRA
UEA—HEBhEREEIZRRINDY—ILFVTIZ BERED ID AR TRINDE
SITHYELIz, ThlE VST TIVRTL v avvT &M T 51012, EDERR
ENEBIZEITINDIOMERFRBIBRIZILET,

BEE—F

NEY—)LEIR—DY I DINEY—IL: BEE—FRDY—ILRYIRIZEAEY—
JWEN—HyiavDEY—ILAF-IZEBNESh, E7/O0—)LITTF43—ERS LT
TAR—CEFEESTIADBIESIZHYELT=,

BHOIO—DOFRE: BAETOIO—HOBENHEINE LIz, BEANYENTT
[C70—DRBNEIZHEIBEE . V—ILN—DIZ,SVRAR—MIHIBAICEE
RL (Rewind to Beginning)I/hR2>%9)vo3 5L BEANYFDOHREN IO T
IRDFREEETRYET  SHIC. BAELGALRDO7O—IZHELI-I5E. BL
E—FDARUNTARTUA D BEEIMICEFHFINET,

HRI€E—F

EIRITLE 12— D4 R IORTEHDRAT—HRN—IZHEIER—L (Whole Page)]
F= (I R—SOIE (Page Width)IFRE22 %) v o3B3 ET, HIRITLE 2—% R
—TDEIZEHLETERTRITAIN. R—VDESCEHLETERTRTHINTERTEE
7,

ENRIAICT RTOLAT7HMERR: ERIE—RT [Ctri]+[A] (Windows) F7-I%
[Command]+[A] (Mac) Z#F & LATIRARILADT RTOL AT EHER
ENFEY,

Jin—H)L<—%

TOIRTFAIRRILDM)\—H )LI—4 (Rehearsal Marks) 17 IL—TIZFskEnt=
[EEETX AR (Prefix)IETEREBTFRE (Suffix) I TA/NSTAEFERTHE BLD
YIN—YIILX—DIZHARBLDEET I ANEEIRKETFAMNERRTEET,
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KEDJTIL—T{t

TIFDKRE: TREEA T3> (Notation Options) JDTREF (Rests)R—TIZ
RSN TF-TEAF (rregular time signatures) 12> aviz, ITERFEED /N
MDA FF (Rests in bars with irregular beat lengths) 47> a> h Et=1Z1B
MENFELz SOFTavIzkY, 7/8 AF (3+2+2/8 Ffzl& 2+2+3/8 D K3IZ
BERYEY) BEDEHEFO/NHDORBAEIZHAHARFE. TELEITALGLE
TRIMAFIZHE TS (HEFECHKRBTESHT (Allow to cross beat
subdivisions)l). F-IEKRFDELZYELTERTRTSH ((HICEHLETKRFES
& (Split at beat subdivisions)]) Z:EIRTEET,

RREEREE

AA7 EDREMICITRTDTATLDORTEREZEETEDLIIHYEL. H
SMLHEERSNT 4 DDA ZANLRRT 50 RAEBFNEH A XS H/3—
TUMIKBEIETHAREALBEREZRETEEY,

HOMLHERINTZ 4 DOHALROVWT DR TERELEETHICIE. 7AT
LZEZFIRLT, TONRTAARILDOT—& (Common) 1T IL—TIZH BT R—)L
(Scale) ] FO/ T 4EAUITLET, YA XIEUTD 4 DIHYET,

o ¥ (Normal): 7ATLEZREEHS (X BEDEBLDHAXIZxT S 100%)
[ZEXELET,

e Xa— (Cue): 7ATL%Z.IFEALFTF 3> (Engraving Options)|DIFa—
(Cues)IR—VIZH B F21—FFDFEZE (Cue note scale factor)JA T3y
THELEYAXIZERELEY . TI4IME 75% TY,

o EME (Grace): 7ATL%E. MEEATay (Engraving Options)IDIE
B (Notes)IR—DIZHAHMEMBEFDIEE (Grace note scale factor) |47
AV THRELEYAXIZEKRELET ., TIAILME 66% T,

o Fa—%¥MiF (Cuegrace): NEMEFFDMEE (Grace note scale factor)]
[ZIF2—FRDEEE (Cue note scale factor)IZMFbhhEET, TIAILE
[X.66% D 75% &iidt=6.49.5% T,

EEDOEERTTATLOBEREEETBHICIE, TONTAARILOT—#%

(Common) 1T IW—T2HBTHRAALRE (Custom scale)lF7A/NTa&FAIZL
F9 . COEHERIE TR —JL (Scale)lF7O/TF1hoBONE=HAXIZLERETS
BCERINET, zEXIE TR —JL (Scale)l7O/8\T4%Fa1— (Cue)lHA
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RIZRELI=SZA T [hRZLRE (Custom scale)]7A/NT4% 50% IZFREL
12BE. COTATLOYAXEBEYFAXD 75% D 50%. DFY 37.5% IT74:
YEJ,

Ao—

NERE )R ERD D3V Eyh: TERE (Edit)] » THHEZ) YR (Reset
Appearance)lB &UTRISa %t vk (Reset Position)lIZ$H 1+ 5 X 5—IZR
TRHEMENREINELS=, 5 8]ZVU Yk (Reset Appearance)ZEiRT 5L,
AS—DEIFIZH LT, RAS—OE DI O—ILRA VAT IHILEDRREE
A= EYEEIC) yhESn b K512 YEL, RO avE) vk (Reset
Position) |Z&iRT 5. R5—DIAVO— LIRS DAL E (FEFINET,

ERINIL

HRINILVDRRIANTELEEZT S TLAF7IMEFa> (Layout Options) D
MEER A (Staves and Systems) IR—U(2H LRI DHEBEDERSAIL
(Staff labels on first system) 1B KU T RO DFERSR)L (Staff labels
on subsequent systems) 1A 7L arvE L EEFTAHIET. BEDHEBEDIERSAN
IWORTREITE] TE], FETGLINGERTEES  MERRUYZEERL T,
HERTY DA AFEERLTHS, FESn-IFERSRIL (Staff labels) 1T A/
T4%I582 (Full)). T&B& (Abbreviated)], E£1=IXM%L (None)lIZRELET .

ERINIVICAV ARG ILAVRDE Y FERTT D BRIDA ALY ILAIRIDLN
T.EVFEERINILO—FELTRIRT INEINEIBETEDLIITHYELT=,
AVRRYIIL AV D AR ERET DICIE. RRELEDAV ARG ILAVRDEIY HTH
NE=TL—Y—Dh—FZEEL. AV RRYILAVRRIZTIIRRA U A—EEHET
B> 12 RREETHLYVRARELED)vILTAVTHF RN Za—FRRL.
[ZBT4fRE (Edit Names)Z:&8IRLET,

FHINF-IBRFERT (Show transposition) AT avIZld 3 DDEHLHY.
NFTLATIrATF 3> (Layout Options) DI Ek&R E4HER (Staves and
Systems) IR—UZHBHFERINIVICAO AR ILAV D ERERT (Show
instrument pitch in staff labels) 1A 7> a  LEELET,

o EITERFE (Always): MEBRSRIVICIVARIILAVIDETRERT (Show
instrument pitch in staff labels) 1AZ 7 DIHFETH, EERINILICAV ALY
IWAVRDEYFEREIZRRLET,
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o LAFTYRATLavIZH#5 (Follow Layout Options): [S#RSARILICAV R
YILAVEDBERERT (Show instrument pitch in staff labels) 1AA > D&
FEAVARIILAVRDEYFERRL. A TDEEFERRLEE A,

o HICIERT (Never): MBERSARILICAVARIILAVIDEREERT (Show
instrument pitch in staff labels) 1AZA > DB E TH, EERINILIZAV ARy
IWAVRDEYFEREIZRRLEE A,

Fl. BELEEBRINIVEEBINIFERINIVICAO AN LAV D E Y FERTR
FTEIMEIML, [ELBFERSRILIZERT (Show in full staff labels) ] &M EREE
NI=ERSAILIZERT (Show in abbreviated staff labels) IZFNEFNZRTET S
CETUIRETEDLIITHYELT,

FE

EROHEICHTHREDFAEL, RE (Edit)] » ROLavEUtvk (Reset
Position)] (FT9MRZUt vk (Reset Appearance) ITIEHYFEEA) FFEHATHE
JEyhEhFET, Ff-. ENZDLDOEBRL TR a0 % yk (Reset
Position) |ZRiRTEL BH NI IL—T DI RTOEFOFREORSE )Y
bCEFET,

TR

BT UORERDHAR: BENTUREREDTO/NTATHRABISHESATL
530 (LA TFRAMDTONTAHEET, ERBLHLVESR) (L. HAED
RRSNBESITHBYFELIz, COHARIE, TEa— (View)] » THAF
(Signposts)] » TFR (Tempo)I1Z:EIRTHIET, RREFRTEUYEZS
nEJ,

B DEDTUREEEANTS: [Shift]+[T] DRYTA—/N—IZ, t=EZIE
FAllegro (q=120)1D &3IZARA/—LI—VZEFIMZANTAALIZHEE . Dorico
(ZBERIZTEINDE (Parenthesized)17O/N\T4ZAVIZLET,

T¥ Ak

FEADTIXIRANTATLIX, TIHILTHARBRRREINDKSIZHYELIz, DA
AKRIE. TEa— (View)] » THAF (Signposts)] » IFFX+ (Text)1Z:&IRT S
CET RREFERTEVYEZONFT,
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4

L Jd4TdLAA1: L. (LtJaTL., £zl letringl) 21ERTRTEDEIITHEYEL
t=o BAEBMT HEHERINL, TONTAIRRILDOTZHEKH (Notes and
Rests) 17 IL—TF(ZHBILtTd+4TLARA (Laissez vibrer tie) T O/ T4ZF I
LET ., TIHILETIE LETATLEA1E. THEA T3> (Engraving Options)]
DI 3A (Ties)IR—VIZFEFRSNTIZIRE (Length) 1ol avITiEEINLIRED
R/METRIRENET  FMTOBKOERELZRET ILENHLGE (. FEET—F
DIEEDHETITEAET,

HEF T ay: [HBEATLaY (Engraving Options)IDMEA (Ties)IR—T(Z,
AADEREIDR/ME. LETATLAL Fa—DRNVELUVRERICHIFI(GE  FL
WA TavhBmMEnELz, Tz, BRICKD2MIZE TR LUVRHRO RS,
RRIZEDEMIB TR DEERLMHR. TEECETAIAMO—VDREENMEIZR
TE5FToavhBmEnELfz, €8T 15 OFLLA T avsBmEnEL -,

HFEE

FlLYBEAEVAFICHITHNERFOTH 1 TREEEA T3> (Notation
Options)IDMRFF (Rests) IN—U (M E{li &YHBH ZLMEFITE T 5/ HRFF
DTH A2 (Bar rest design in long time signatures) 147> 3> M-I 2B
SN FERE 412 211 O&SHAFRBEFEAT L. 2FFLYRVT2L—
LAV QINATIE, INFRFFIZRE S (TL—R) KEFEFERTIH. £ (E3TL—
N) KFEERTINEERTELLSITHYELS,

NAYRIEDDRFERS: HEIC 2 PEFEEAIIHEFLESTHNE, 2/2 st
THHAYFIEVREBSEFERALTRRTESLIICGYFEL - RRDAETIE. CDES
FEFERALTRRINDDIE 2/2 I3 TETH BENGRETIE. 2 7 EFEHE
[ZERYTHMtDBFEETITEAVIITRVRESAERSNTOELZ, AVFIEVD

NEEFERTDICIE, Ta/RTARIILOTMEFES (Time Signatures) 17 )L—7
[ZHBMTE/HYFTIEY (Common/cut common)IFANTAEAUIZLET,

A

TONRTARRIDOTERF (Tuplets) 1V IL—T I, TERE/NFRTHE (Split
notes at spanned barline) I 7O/ AT A FHf=ITEBMSNELT =, NNETIREE-CE
B TN #8£ET-< (Spans barline) ] 7A/8 7«2, 1 DO AFENTRRS
NTWLEEIC, TEFZE/IMERTHEl (Split notes at spanned barline)1&#4 >
29 5L TDEFADPDEIREFECERE. NMIROLE TRATHEIINET,
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A—Y—A(22—T71—X

REDEGL: NRERE (Preferences)IDI £ (Genera) IN—VIZHHEERT
HEMEBA (Preferred unit of measurement) 1A 7T av 7 TYr—av 2k
TYLSRBENDLSITHEYFEL =, FFHLWEGEELT, 2 FA—RIL (cm)
(Centimeters (cm))JABMNESNELIz, AT, A FA—ILORSIERA UL TIEE
TEODELHYELD . BIFADBEMTRIZR RN CTETALIITHYFEL -, £
UG EEZ N TACLT. EDEMEFERALTHLRIZHEETEALIIGYFL
Tz

o KAk pt

e =SIJA—F)L:mm

e A F:in FrIL "
o TUFA—kJL:cm

[LL7IhAFLay (Layout Options)IDTR—IERTE (Page Setup)]R—TIC
0. R—UOIF. R—CDES, BEDOES, A—UPEHIL—LORAKLEIS
B33 b0—LIETRT EHEBRICEIANEZIFR/TEESIHYELE, &
EE—ROTONRTFARLDITL—L (Frames) 1T L —T=HDEETO/T ¢
HE%KTT

F—R—Kka—rhyb A—F—FEDF—HR—FIa—tOVrDREFENRE
SN, A—F—HmEm, 8., FIEEIBRLIzF—HR—F a—thybDOHHBREFS
NBELSITEYFELIz, DFY. Dorico DFHREFHICKYEBMEIEEEIN=TD
AIEDF—FR—Ra—bAvbE, ERODI—HF—ELZOFFRATEET, TS
ZFETEMLIZY., F—R—Fa—rhvrE) YL THREILDF—R—F 3
— Y NERUINSEYELEYT B2 EXHYFEE A, Dorico 1.2 Z#HTHRET
BLE BREOI—Y—IZIURESN=F—HR—Fa—rhyrI7MILIEBEEMIC
FLOERICERSNDO. FHLOT I LD F—HR—Fa— Ay ET T,
21— —HAFATEET,

HIUE—IS—bDLATIREGYEZS: T942F (Window)] » Thoo4—
IN—FDLAF7IF (Counterpart Layout) I RMBFHI=ICEBMESNELT -, T4
ILEDF—R—F2a—rAYMMETWITY , COATURIE BAEBIRDOT7AT LI
EDOWT. FZIWNRIATLAT IOREN—LAT I Y B ZFET, LA ET)LRT
TFLATIRERELTNADEEIZ, Violin 1 DERDIEFILELRINLTIWIZEHE
F&WViolinl DIN—kLATIMIUYEDYES , /IA\—kL AT MIUY BT
RETES—EIWIZERTE, JILRIATLATIOMNIRYET,
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R—UDH%E: [HRE (Edit)] » 8B (Go To)l » [R—SD#BE) (Go To
Page) I A 7RI W FHzICIEEMEN . MEDL AT IFDEDR—UICTHLHREH
BTEDLSIHYEL

TONT4: TANTAZEFAUNTTBDIT RIAFRRAMYFEF TV IRYIRDME
AEFERLTW=TO/RT1D— 8% RSAFRRIvFDHDERICEIELELS:,
TOIRTAERRMICA DIZTEDLIICT IRENHDHEEIE. FTvIRVIAMN
WELRYFETH. UNTRAIOEMBZ R (Grace note before barline)17A/37 1,
T—T4Falb—>ar, O—FE&. MEES BAFRELERTICTETANT 1,
MBI BDIIEINDE (Parenthesized)ITANTAHE | —EBDOTA/TA(ZH LY
T.INHDEBROTERESNTUWVELS, T, T@HBEEZERT (Show intensity
marking) 170/ T4[EFEDEKRICHE>TULV 1=, [ARBEREEIERT (Hide
intensity marking)JIZIEIEShFELT =,

ToTL—bk Hub 94 R OELUIT7AIL (File)) » T — M OERIER
(New from Template)J 4T A=a—IZ TO¥%X (Jazz)lh7T3)—hBEMEN, O
YA A O AWMEE, BLUEYIT NURDTUTL—MDF=IZEBMEhEL
=

REFEALE-TR I Hub D4R OREFERLE-TOD D) AN S,
BR2OTOC I EEIBRTESLIITHRYEL, YR SEIRT STO IR
J)wIL T, RRSNZAVTFRAMAZ2a—hSIREFEALETAS IR SHIR
(Remove from Recent Projects)1Z#iRLET,

TRz IMER: TI74)L (File)) » TR HMER (Project Info) I, #if=IZ
[<1&M>IRAUMNEMENh, HE70—DRMICHKRELBEITEDLSITHYFELT,

ATarDFATAY: BFEATaAviGE  BER—UHSEEZFTATATDER
—CDRIO— VBN, FA47 0T NV TOSREERIFSNSKSIZHY., thd

R=VIZHYBZ THBITTDR—V(ZRSIIGE . RAVA— LA ENBEIMIZTD

R=TD—FBLICRS>TLESENGLKBYELIZ, FAT7RTEFALSE. TRTD
RyO— )L EERIE)EybShET,

INDAF—IR

LAT7IMITL—Y—&BMEEHIBRT S LATIMIETETL—r—0iENn
FEIFTHIBROMIEAL, HERIYKIBICEGYFE L=,

BHEFICETH2EROAN: BRAFTERHLI7O—DRDHDYTHOEFAAD
BRENHESNFLI,
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BREFTATOTERC BEFT T avE BN OERR—UHBHEEF (70
Jh. REMICENEICBKESITHRYELT,

HROMAZNTODIOM EROBNAZWNTODIIMNDREREN A LELEL
T=o

A—AS5M4E¥—3ay

TIHIWEDR—=TUH AL XDFER: TRIBJRTE (Preferences) | DIE£H (General) )
R=IIZIF 2+ DAY 14X (Default paper size type) 14T 3> hi§Et=IC

BmMEnFELz, ThITKY, FiIRTAS o IMERBT 5. T4 DR (X
(ZT4258—F33F )L (International)] (1SO216, 3—RAE 7>, A—bILiED B

HAXT.A3 A4 73E) ZERTSHM.TdE% (North American)l (L2—. 4270

AR E) ZERTEINEERTEDLSICHYEL . TIHILRTIE,. 2DA T av
(ZITBEbh (Automatic)lI[CEEESNTLET, CDHFE. AVE2L—F—DA—/)LE
EE TR TEEFERALT. T4 LTCERATIAMY A INRESNET,

FTavDFATATIZE T HR—CDRTIE: FEA T avGE BRR—UH
BEHF T avDFATAT DR—UORRIEL, RERDIEE TG 12—
—AUA—D1—ADEFBITEICELVLETIEIZY—rEh b ESI1THY FEL
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ID # Component Issue

STEAM-6686 Articulations Stem-side articulations on stemless notes (e.g. whole notes) no longer collide with single-
note tremolos.

STEAM-6766 Articulations The options in the Ties section of the Articulations page of Engraving Options can now be
set correctly through the user interface.

STEAM-6767 Articulations Adjusting the Y offset of an articulation on a chain of tied notes now correctly applies the
offset even if the end of the tie chain on which the articulation appears is overridden.

STEAM-7133 Audio export Exporting audio to a UNC network path (e.g. of the form ¥¥server¥folder) now works
correctly (Windows only).

STEAM-6692 Bar numbers Bar numbers now correctly appear above the system as expected if the top instrument in the
system uses a single staff line.

STEAM-7037 Barlines Dashed barlines representing subdivisions in aggregate time signatures now appear
correctly following an instrument change.

STEAM-7030 Beams Selecting a note and an implicit rest and attempting to beam them together no longer
sometimes results in a crash.

STEAM-6612 Under some circumstances, the graphical chord symbol editors could show some

Chord symbols  components either as being deletable or non-deletable incorrectly. This has now been

STEAM-6672
resolved.
In larger projects and/or on slower computers, clicking outside the chord symbol popover

STEAM-6825 Chord symbols ger proj puters, 9 ymbot pop
after typing a chord symbol could cause a crash. This has now been resolved.
Increasing the Y offset values in the graphical chord symbol editors now moves the selected

STEAM-6847 Chord symbols 9 grap y
component upwards, as expected.

STEAM-6872 Chord symbols Chord components that use graphics are now positioned correctly and stably.

STEAM-6757 Diagnostics On the rare occasions when Dorico crashes on Mac, it will now leave the expected crash log
behind in ~/Library/Logs/DiagnosticReports.

STEAM-6788 Dynamics Properties that are set when creating dynamics by typing them into the popover (e.g.
parenthesizing a dynamic) can now be correctly unset via the Properties panel.

STEAM-6852 pffr Dragging the inflection point in the middle of a messa di voce dynamic now works reliably for
grouped dynamics.

STEAM-6910 SIS It is now possible to set the dash length and gap for gradual dynamics whose continuation
lines are drawn dashed in the Properties panel.

STEAM-7117 Dynamics Hidden dynamics now show signposts. The Hide dynamic intensity property now also
always takes effect, rather than only when the custom prefix or suffix properties are set.

STEAM-6679 The automatic generation of flenames when exporting flows and layouts either as Dorico

STEAM-6821 Flows projects, audio, or MusicXML has been improved, so that illegal characters are removed

STEAM-6915 correctly and the filename does not end up extremely long.

STEAM-6726 Flows Split Flow will no longer position notes and other rhythmic items after the split incorrectly if

the position of the split was followed immediately by implicit rests and tuplets.
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ID # Component Issue
. Inputting a key signature onto a single instrument by clicking it in the editor in the Ke
STEAM-6831 Key signatures puting y signatu Ingle Instru y clicking 1t tor 1 y
Signatures panel and holding Alt now works correctly.
When adjusting the horizontal position of lyrics to minimize distortion to the ideal rhythmic
STEAM-6639 Lyrics spacing, lyrics could sometimes be adjusted incorrectly such that they would touch. This has
now been fixed.
STEAM-6735 Lyrics The horizontal position of a hyphen at the start of the system can now always be adjusted.
STEAM-6730 Multi-bar rests Multi-bar rests that are too wide to fit at the end of the system at their ideal width no longer
sometimes cause part of the multi-bar rest to extend incorrectly beyond the frame edge.
STEAM-6824 Multi-bar rests Under some circumstances, single bar rests drawn as multi-bar rests could cause too much
music to be forced onto a system. This problem has now been resolved.
STEAM-6344 Note input Under some circumstances, adding ties to existing notes entered with forced durations could
cause their duration to be changed unexpectedly. This has now been resolved.
. The enharmonic spelling of notes input from a MIDI keyboard has been further improved,
STEAM-6497 Note input fmonic spetling s 1npu a yhoar S Hriher improv
particularly in minor keys.
Inputting a tied note using Force Durations no longer unnecessarily results in two distinct
STEAM-6541 Note input notes tied together, instead producing a single note with the appropriate properties to split it
with ties at the desired position or positions.
. Very long n hat hav n split into chains of tied n itions th re no longer
STEAM-6630 Note input ery long notes that have been split into chains of tied notes at positions that are no longe
valid now have all such splits removed, in order to ensure that the note can be notated.
The option Notes starting in the middle of the beat ending at a beat boundary without
STEAM-6656 Note input crossing the half-bar on the Note Grouping page of Notation Options no longer incorrectly
takes effect in time signatures that do not have a half-bar.
STEAM-7270 Note input Mouse input onto single-line percussion instruments has been improved.
. Under rare circumstances, enabling the note spacing tools in Engrave mode could cause
STEAM-6720 Note spacing 9 pacing 9
Dorico to hang. This problem has now been resolved.
. Using Alt+right arrow to nudge a grace note’s spacing column no longer incorrectly removes
STEAM-6789 Note spacing 9 9 geag P 9 9 y
the entire spacing adjustment.
STEAM-6477 Omaments Glissando lines from grace notes that precede implicit rests will no longer be incorrectly
removed if the implicit rest is made explicit.
STEAM-7109 R cnts A problem whereby adding a slur could cause a trill continuation line that started on a
previous system not to appear has been resolved.
A problem whereby systems could be spaced unevenly by default on some pages has been
STEAM-6513 Page layout P y sy P y by pag
resolved.
ingle-lin ion instrumen no lon in I Dorico’ ical
STEAM-6769 Page layout Single-line percussion instruments are no longer incorrectly treated by Dorico’s vertica
spacing algorithms as if they have zero height.
STEAM-5820 Performance Selecting items in projects with multiple flows is no longer sometimes significantly slower

than it should be.
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STEAM-6666 Performance The speed of inputting music into projects that use open meter has been improved.
STEAM-7106 Performance Dorico now filters out System Exclusive MIDI messages sent by MIDI input devices, which
could previously cause Dorico to become unresponsive.
STEAM-4870 Play mode The order in which tracks appear in Play mode now always correctly reflects the order of the
players in the current layout.
The non-functional edit button in the VST Instruments panel has been removed, and the
STEAM-6925 Play mode uncti It bufton 1 u P v
display of which plug-in is currently in focus or selected has been improved.
A problem whereby the playhead and time display in the Transport would stall during
STEAM-4736 Playback playback, which could subsequently cause the score display not to update correctly, has
been fixed (Mac only).
STEAM-4936 Playback Edits made to dynamics are now reflected immediately on playback.
STEAM-6586 Playback Further fixes to the playback of relative tempo changes using a beat unit other than a quarter
note (crotchet).
STEAM-6947 Playback pizz. playing technique now plays back correctly at the start of the flow (Mac only).
STEAM-7084 Playback When starting playback, the first note is no longer sometimes much quieter than normal.
STEAM-6846 Project files Dorico can now correctly open project files saved in Microsoft OneDrive using the Files
On-Demand feature (Windows only).
STEAM-6388 Rehearsal marks Rehearsal marks left-aligned with the systemic barline are no longer sometimes incorrectly
vertically positioned.
STEAM-6496 Repeat endings  When duplicating a flow, repeat endings are now duplicated correctly.
STEAM-6514 Rests It is no longer sometimes impossible to unset the Rest position property on an explicit rest.
STEAM-6553 Slurs Dragging a middle segment of a slur that crosses two or more system breaks in Engrave
mode no longer causes a crash.
The si f staff labels i I i h ff size i h f th
STEAM-6590 Staff labels e size of staff labels is now correctly determined by the staff size in use at the start of the
system, including a size change set by way of a system break.
h h ff label h style will icall Il staff label
STEAM-6899 Staff labels Changes to the Staff labels paragraph style will now automatically update all staff labels
correctly without requiring you to switch to another layout.
STEAM-5220 Text The point size shown in the text editor popover no longer varies depending on the current
zoom level.
STEAM-6402 Text A paragraph style and a font style set to the same point size now draw at precisely the same
size.
STEAM-6687 Text Using Reset Position on a text item no longer also incorrectly removes any overridden

formatting.
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STEAM-6906 Text The Relative size control in the Character Style dialog no longer always incorrectly shows
zero, rather than the chosen size.
STEAM-6907 Text Changing the size of a character style after using that character style in one or more text
items in the score will now update those text items correctly.
. . Dashed bar divisions in aggregate time signatures now draw correctly following an
STEAM-7037 Time signatures gareg 9 y g
instrument change.
Dragging a single-note tremolo on a down-stem note in Engrave mode no longer drags the
STEAM-7162 Tremolos gging a sing W n =ngrav gerdrag
tremolo stroke in the wrong direction.
STEAM-6870 Tuplets The positioning of the tuplet ratio digit for duplets has been improved.
Deleting the final note from a tuplet at the end of a flow in open meter no longer causes the
STEAM-6914 Tuplets 9 P P 9
music at the end of the flow to be drawn incorrectly.
Deleting the final note from a tuplet at the end of the flow in open meter now correctl
STEAM-6914 Tuplets 9 P P y
updates the flow.
STEAM-7060 Tuplets The horizontal position of tuplet ratios for tuplets without brackets has been improved.
Some complex operations would not redo correctly after being undone, or would not leave
STEAM-6426 Undo and redo piex operations wou r recty g u » orwod v
the expected items selected. These problems have now been resolved.
Th D in the T ial I | hen No. of
STEAM-5517 User interface e Up/Down buttons in the Transpose dialog are now correctly enabled when No. o
octaves is set to anything greater than zero.
STEAM-5699 User interface Under certain circumstances, changing between page and galley view when there is no
selection can now keep the same area of music in view.
STEAM-6501 User interface The order of the Hub and Help menus has been swapped, so that Help is the right-most
menu.
STEAM-6665 User interface When a spin control in Properties has an inconsistent value, it is now possible to set a
consistent value using the keyboard rather than only by clicking the paddle buttons.
STEAM-6774 User interface The context menu for adding players to layouts no longer incorrectly shows the names of
player groups instead of the names of players.
STEAM-6816 User interface Under some circumstances, changing page in the Layout Options dialog would ask you to
apply unsaved changes, even when no changes had been made. This has now been fixed.
STEAM-6823 User interface Various horizontal alignment properties no longer incorrectly show a non-functional Justified
option value.
STEAM-6927 User interface The Can slope property for tuplets has been replaced with a simple Force horizontal
property, which more closely reflects its actual behavior.
STEAM-7056 User interface Under some circumstances, making an edit after closing one window for the current project
could cause a crash. This problem has now been fixed.
STEAM-7116 User interface The Reset to Factory buttons in the Engraving Options, Notation Options, Playback Options

and Note Input Options dialogs all now correctly restore factory settings.
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